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Preface 

Have you ever spent hours going through long software manuals and endless forums trying 

to work out how to analyze structural MRI scans? We used to do that too, so over time we 

have documented how to use a wide variety of software packages so we could conduct a 

large variety of analyses. We have also received training in some of these packages which 

has enhanced our competence in these programs. 

 

We don't claim to know how to use every module of every program, but we know how to 

use them to conduct most of the analyses that you are likely to want to run. We have 

utilized what we’ve learnt by publishing dozens of peer-reviewed papers but also passing on 

this skillset to many students and research groups around the world. 

 

Chapter 1 of this Handbook focusses on step-by-step instructions on how to use various 

packages to process structural MRI data. 

Chapter 2 of this Handbook focusses on white matter anatomy and the placement of region-

of-interest seeds using diffusion MRI data to perform tractography. 

Chapter 3 of this Handbook describes how to setup a virtual machine with software 

necessary to process structural MRI data. 
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CHAPTER 1 

 

Introduction 

Whilst there are many neuroimaging packages available, we have found that those we 

describe in this handbook have collectively been sufficient to analyze structural MRI scans. 

However, we encourage you to seek alternative packages if you do not find these ones 

adequate to accomplish your tasks. 

 

In this handbook, we provide step-by-step instructions in how to use your data to conduct 

the analyses you require. The focus of this handbook is T1-weighted and Diffusion data 

acquisition and analysis. 

 

Topics covered in this handbook 

• Minimum computer specifications 

• Installation of these packages 

• T1-weighted and Diffusion Imaging 

• Other structural sequences to consider 

• What is T1-weighted useful for? 

• What is diffusion imaging useful for? 

• Issues to consider before acquisition 

• Software 

• Pipelines/scripts to save you time 

 

Minimum computer specifications 

Windows (pc), Linux/Unix, Macintosh/Apple 

The bare minimum specifications are Core2Duo CPU with 4GB RAM, but, of course, it’s best 

to have the fastest CPU with multiple cores and the most amount of RAM you can access. 

Same goes for the hard drive capacity: at least 250GB but the bigger the better! SSD (Sold 

State Drive) will also speed things up a lot. 

Although you could have a pc running Windows and Linux through a virtual machine (VM), 

this is not an ideal setup as VMs are notoriously slow. By contrast, a dual-booting pc would 

be far preferable (that is, Windows and Linux on the same pc with a simple boot menu when 

you turn on the pc). If you have a Mac/Apple, then the best setup is to run the Mac OS 
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natively and then install dual-boot software such as Bootcamp or Parallels and then install 

Windows onto that. Note the Mac/Apple is essentially running on Linux, so you simply open 

a terminal and you immediately have a type of Linux running natively – very handy. 

Although similar, Mac and Linux are not the same. 

Of course, if you have access to a supercomputer/cluster via the university then you could 

run all of your analyses on it, but note that those huge mainframes sometimes have 

problems and need to shut down to reboot which may interfere with your batched analyses. 

Note that not all MRI analysis packages are multi-threaded i.e. they do not use more than 

one CPU or core at a time, whereas those that are multithreaded can utilise as many CPUs 

and cores as you have available on the computer. Again, very handy. 
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Installation of these packages 

Many of these packages are simple executable (.exe) files than run natively on Windows. 

However, some run only on Linux/Mac (e.g. FSL, FreeSurfer) so need to be 

installed/compiled with the correct paths and calling the correct files; sometimes you will 

need to install updates via apt-get (depending on your operating system flavour). Some (e.g. 

FreeSurfer) run in separate shells (e.g. tcsh or csh). If you are a Linux/Mac user, you may find 

it convenient to run the Windows packages via VMs, or use Windows emulators such as 

wine. 

 

T1-weighted and Diffusion Tensor Imaging (DTI) 

Without going into the physics of it, T1-weighted is essentially the sort of scan you acquire if 

you want data with good gray/white matter (and cerebrospinal fluid; CSF) contrast. The 

word ‘contrast’ in this context means the clarity of the gray/white matter (and CSF) borders. 

This is very important when segmenting regions of interest (ROIs) as they rely on clear 

gray/white matter and CSF borders. However, the clarity of these borders is also important 

in the clinical context as a lack of contrast between gray/white matter can sometimes 

indicate poor structural integrity as occasionally seen, for example, after traumatic brain 

injury (TBI). A type of MRI sequence that investigates this more thoroughly is referred to as 

MTR (magnetisation transfer ratio), but that’s beyond the scope of this handbook. Note as 

well that MP2RAGE (T1-weighted with multiple TIs) is not suitable for most of the software 

we go through in this Handbook. 

Diffusion tensor imaging (DTI) was released in 1994 by Basser and colleagues but not utilised 

widely until processing power dramatically increased in the early 2000’s (see our article 

reviewing this, Maller et al., 2010). Filler (2009) provides a comprehensive description of its 

origins. It is based upon DWI (diffusion weighted imaging) but instead of 2-dimensional data, 

DTI acquires 3-dimensional data (or 4-dimensional, depending on how you look at it). 

Essentially, DTI produces data based upon Brownian movement i.e. the movement of water 

between microscopic white matter fibres based on heat. Water will move in a straight line 

that is directly parallel to the direction of the white matter when the white matter is 

‘healthy’, but the water will move in different directions when the white matter’s “integrity” 

is compromised. As an analogy, think of a bowl of spaghetti… Another useful analogy is a 

hose with water flowing through it: when the hose is new and has no leaks the water will 

move parallel to the hose, that is, in an anisotropic direction. Isotropic means the water is 

moving equally in all directions, hence, anisotropic means in one single direction. When a 

white matter bundle is damaged, it may be compressed or stretched, leading to leaking in 

that white matter bundle – this will cause the water flowing within it to leak out the side or 

its flow to be obstructed, leading to the water flow no longer being parallel to the shape of 

the hose i.e. the white matter bundle. When the water flows parallel to the hose in one 
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direction, the ‘fractional anisotropy’ (FA) has a value of 1; when the hose is leaking and the 

water flows in all directions equally (e.g. up, down, out the sides), the FA is closer to 0. 

The basic physics of NMR is nicely demonstrated here: 

http://www.youtube.com/watch?v=1OrPCNVSA4o  

 

Other structural sequences to consider 

• T2-weighted, T2-FLAIR, susceptibility-weighted imaging (SWI), arterial spin labelling (ASL) 

• T2-weighted is a scan acquired when you want to look at possible pathology, for 

example, white matter hyperintensities (WMHs), strokes, plaques, tumours, cysts, etc. In 

normal ageing, WMHs first appear lining the inner border of the lateral ventricles, 

referred to as periventricular leukomalacia (PVL), which often begins after the age of 40. 

Large WMHs within cortical or subcortical matter are often representative of pathology, 

although collections of WMH ‘dots’ can be as well (sometimes referred to as ‘punctate’). 

For example, these can be representative of WM disease sometimes related to late-

onset major depression. The rule-of-thumb is that one WMH per decade is within 

acceptable limits. T2-FLAIR is like a T2-weighted scan but the colour of the CSF is 

inverted. That is, instead of CSF appearing white, it is black on a FLAIR scan. Hence, FLAIR 

stands for FLuid Attenuated Inversion Recovery. SWI/SWAN focusses on the 

susceptibility of iron and myelination, hence, it is “susceptible” to alterations in iron and 

myelination. ASL is a sequence used to assess absolute measures of blood flow, rather 

than relative blood flow such as in dynamic contrast enhanced MRI (DCE-MRI). However, 

ASL is associated with quite high SAR (specific absorption rate), so sequences cannot be 

too long. 

 

What is T1-weighted useful for? 

• T1-weighted data has a variety of uses, but in the research context, it is used mostly for 

investigating gray matter (GM), white matter (WM), CSF, and atrophy. 

• Volumetrics. GM+WM+CSF=intracranial volume (ICV). Total brain volume (TBV)/ICV = 

opposite of CSF/ICV. That is, TBV/ICV is a measure of how much of the cranial vault 

contains brain matter, whereas the opposite (CSF/ICV) is a measure of how much of the 

cranial vault is not brain matter; hence, CSF/ICV is sometimes referred to as a measure 

of atrophy. Note that some programs (e.g. FreeSurfer) yield data of TBV and ICV but the 

TBV does not include blood vessels, choroid plexus, non-brain matter constituents, 

hence, TBV/ICV in those programs will be smaller than programs that assume everything 

within the cranial vault is either brain matter or CSF (e.g. FSL’s FAST module, or SPM’s 

segment routine). 

http://www.youtube.com/watch?v=1OrPCNVSA4o
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• Thickness. Cortical thickness is representative of how thick the cortical gray matter is. 

Essentially, volume = thickness x area. 

• Curvature/shape analysis can also be accomplished with T1-weighted data, but its 

meaning is less straight forward. 

What is DTI useful for? 

• WM Structural “integrity” and directionality 

• FA, L1 (λ1), L2 (λ2), L3 (λ3), MD, RD. Figure 1 illustrates what the eigenvalues (λ) 

represent (from Maller et al., 2010). 

• Tractography of WM bundles 

• Connectivity 

• Fibre density 

 

Figure 1. Illustration of principles involved in diffusion tensor imaging. (A) Microtubules of 

an axon encased in myelin sheath. (B) Eigenvectors represent main axes directions. Water 

diffusion is restricted along the longitudinal axis (λ1) and/or perpendicular to the 

longitudinal axis of the axons (radial diffusion, eigenvalues λ2, λ3) due to axonal 

microstructure. 

Note that most diffusion imaging is now not considered to be diffusion ‘tensor’ imaging 

(DTI), as the word ‘tensor’ implies that there is one white matter bundle traversing each 

WM voxel. By contrast, we know that around 90% of white matter voxels contain at least 2 

WM bundles that cross or kiss (hence, the terms ‘crossing fibres’ and ‘kissing fibres’), so we 

now refer to this technique as dMRI (diffusion MRI). Different variations of dMRI pulse 

sequences (and analysis techniques) exist, such as HARDI (high angular resolution diffusion 

imaging), DSI (diffusion spectrum imaging), ball-and-stick, and q-ball imaging.  
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Issues to consider before acquisition 

• Scanner type (brand, Tesla, gradients, acquisition pulse sequences installed onto the 

console) and reconstruction algorithms available on the workstation 

• IR-SPGR, MPRAGE (Magnetization Prepared Rapid Acquisition GRE (3D Inversion 

Recovery)), MP2RAGE (MPRAGE with multiple TIs; MPRAGE and MP2RAGE are used with 

GE, Siemens and Philips scanners) 

• DTI, RESOLVE (used for high-resolution q-ball scanning that takes into account crossing 

fibres), FOCUS/ZOOM (used for high-resolution imaging with reduced field of view) 

• Silenz (GE) and PETRA (Siemens) – these are T1-weighted sequences that are less than 

10db above ambient noise level; some are based on the DUFUS and RUFUS techniques 

• Fast scanning/GRAPPA/ASSET, SENSE, SMASH, PILS etc. These are usually parallel 

imaging methods to reduce scanning times although they can also reduce SNR. MRI is 

always about give-and-take in terms of SNR. However, multiband imaging retains most 

SNR until you exceed a certain factor 

• Fat suppression and chemical shift 

• NEX/number of averages – the more averages, the higher the SNR 

• Number of channels (receive coils i.e. antennae) – the more channels the better the 

resolution but also sometimes lower SNR depending on coil configurations 

• Resolution, repetition time (TR), echo time (TE), slice thickness, SNR – you can alter TE, 

for example, but it must not change between subjects, slice thickness should be less 

than 1.5mm for T1-weighted and no more than 3mm for dMRI 

• dMRI number of directions: more directions will yield more accurate tractography (but 

not necessarily more accurate FA estimation), and more b-zero (non-diffusion T2-based) 

volumes will yield better eddy current and movement correction especially when they 

are interleaved 

• Anterior commissure-posterior commissure (AC-PC) alignment – important because if 

you normalize scans to a template then this will make the analyses more accurate with 

higher SNR as the scans will not have to be reorientated to match the template 

• Length of scanning period and each sequence – some people will not be able to remain 

very still for long periods of time, plus longer scans may deposit more SAR 

• Volume of scanner/patient comfort/movement – wide bore scanners are preferable for 

patient comfort and the ability to put more equipment into the scanner; patient 

movement will reduce the quality of the scans 

• Knowing for sure which is right and which is left – sometimes software can flip the MRI 

scan, so it is useful to use fiducials (markers) that show on the scan so that you can 

always be sure which side is left and which side is right. For example, you can tape a 

vitamin E pill to the forehead above the right of the subject’s eyebrow before they are 

scanned so that the right-side of the head can always been confirmed. 

• CAIPI (Controlled Aliasing in Parallel Imaging) reduces the g-penalty factor 

• Compressed Sensing decreases scanning time whilst also increasing SNR  
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Software covered in this handbook 

• MRIcro (visualization, preprocessing, manual segmentation, lesion overlay analysis; 

http://www.mccauslandcenter.sc.edu/mricro/ ) 

• MRIcron and dcm2nii (format conversion; 

http://www.mccauslandcenter.sc.edu/mricro/ ) 

• MRIreg (http://www.mccauslandcenter.sc.edu/mricro/ ) 

• BEAM (http://www.clinicalresearcher.org/software.htm ) 

• MRIconvert (slice conversion http://lcni.uoregon.edu/~jolinda/MRIConvert/ ) 

• ITK-SNAP (T1-weighted visualization http://www.itksnap.org/pmwiki/pmwiki.php ) 

• Not free: Analyze® (http://www.analyzedirect.com/ ). Analyze® is the gold standard in 

manual segmentation software. There is a large variety of freeware that can be used to 

accomplish a similar task, but Analyze® is established as the most comprehensive and 

user-friendly package for manual ROI segmentation. It has a number of modules other 

than the ROI module, but these are beyond the scope of this handbook. 

• FreeSurfer (T1-weighted automated segmentation) and QDEC (FreeSurfer GUI for 

analysis http://freesurfer.net/ ) 

• SPIN (slice conversion and SWI editing http://www.mrimaging.com/category.103.html ) 

• DICOMsort (multi-platform, Linux, Mac, Windows, for sorting DICOM images by any of 

the values in the DICOM header. http://www.dicomsort.com )  

• FSL (http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/ ): Brain Extraction Tool (BET), Fully Automated 

Segmentation Tool (FAST), Tract Based Spatial Statistics (TBSS) 

• DTIstudio (deterministic tractography https://www.dtistudio.org ) 

• MedINRIA (deterministic tractography http://www-

sop.inria.fr/asclepios/software/MedINRIA/ ) 

• MRtrix (deterministic and probabilistic tractography http://www.brain.org.au/software/ ) 

• SPM (for normalization and GM/WM/CSF segmentation 

http://www.fil.ion.ucl.ac.uk/spm/ ) 

 

Pipelines/scripts will save you time 

Once you learn how to use a program, particularly those installed in Linux/Unix/Mac, it will 

save you substantial time (and effort) by writing scripts to conduct multiple-step analyses 

for multiple scans. You just need to be confident in your scripting! An example of this is 

referred to as a “pipeline”. A good example of utilising both T1-weighted data and DTI data 

in one ‘program’ is referred to as the “Connectome pipeline” and another is TRACULA 

(TRActs Constrained by UnderLying Anatomy; 

http://surfer.nmr.mgh.harvard.edu/fswiki/Tracula ), although they may rely on you first 

processing the T1-weighted data through FreeSurfer and then inputting the output of that 

process along with the DTI dataset into the pipeline. However, this can be scripted.  

http://www.mccauslandcenter.sc.edu/mricro/
http://www.mccauslandcenter.sc.edu/mricro/
http://www.mccauslandcenter.sc.edu/mricro/
http://www.clinicalresearcher.org/software.htm
http://lcni.uoregon.edu/~jolinda/MRIConvert/
http://www.itksnap.org/pmwiki/pmwiki.php
http://www.analyzedirect.com/
http://freesurfer.net/
http://www.mrimaging.com/category.103.html
http://www.dicomsort.com/
http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/
https://www.dtistudio.org/
http://www-sop.inria.fr/asclepios/software/MedINRIA/
http://www-sop.inria.fr/asclepios/software/MedINRIA/
http://www.brain.org.au/software/
http://www.fil.ion.ucl.ac.uk/spm/
http://surfer.nmr.mgh.harvard.edu/fswiki/Tracula
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WM bundles: getting to know white matter anatomy 

A widely used reference for this is the White Matter Atlas by Mori et al. (2005), but there 

are many other white matter atlases/articles well worth considering as well, including, 

Wycoco et al. (2013). We encourage you to search on PubMed using keywords such as 

“white matter atlas” (http://www.ncbi.nlm.nih.gov/pubmed/?term=white+matter+atlas ). 

In Chapter 2 of this handbook we have included some general advice on where to place 

initial seed points for a variety of major WM bundles. 

 

Index of software and instructions 

1. How to convert individual dicoms (slices) into an Analyze volume (.hdr + .img): MRIcro 

2. Steps to convert dicoms to Analyze format (.img + .hdr) with dcm2nii 

3. MRIconvert 

4. SPIN to convert a directory of DICOMS containing different sequences (series) 

5. DICOMsort (a multi-platform alternative to SPIN) to convert a directory of DICOMS 

containing different sequences (series) and anonymise data MRIconvert 

6. Preparing a T1-weighted scan for MiniBIRD  

7. Using the Ascension® MiniBIRD (Flock of Birds) for stereotaxic coregistration of MRI-to-

head-and-brain 

8. How to locate the DLPFC (F3 or F4) without an MRI brain scan 

9. Example of tracing an ROI in MRIcro. In this case, the caudate. 

10. Manual tracing of a Region Of Interest (ROI) in Analyze® 

11. Steps for 3D rendering in ITK-SNAP of ROI (object maps) traced in Analyze DICOMsort (a 

multi-platform alternative to SPIN) to convert a directory of DICOMS containing different 

sequences (series) and anonymise data 

12. Inter-rater reliability  

13. FreeSurfer  

14. Protocol to process SWI images from magnitude and phase data 

15. FSL 

16. Tract-Based Spatial Statistics (TBSS) 

17. DTIstudio: How to measure FA (and other statistics) of white matter tracts 

18. MedINRIA 

19. MRtrix 

20. Some useful Linux commands 

21. References 

22. Collection of our published articles that have used the software described in this 

handbook 

23. Imaging guide for tractography of major white matter fibre bundles  

http://www.ncbi.nlm.nih.gov/pubmed/?term=white+matter+atlas
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1. How to convert individual dicoms (slices) into an analyze volume (.hdr + .img): MRIcro 

1. Open MRIcro (Rorden and Brett, 2000) 

2. “Import” → conversion wizard (bottom option) 

3. “OK” (conversion options) 

4. “OK” (flip) 

5. A box then appears: select the very first dicom (i.e. the one with the smallest number at 

the end of its filename: this should be the first [top] file) 

6. “OK” (call is ‘n’, the default name) 

7. At this stage, all dicoms will now be converted to Analyze format. So now we need to 

reslice (slice-and-dice) and have the scan in the correct orientation. To do this: 

8. Open the Analyze file (Open, then select the file) 

9. “Etc” → convert anisotropic to isotropic 

10. “OK” 

11. Open the new isotropic file 

12. Reslice it to 1mm cubed. To do this, look at the top left of the screen and note the length 

of the x and y dimensions (e.g. 0.94mm) and enter that box into the reslicing box: 

13. “etc” → “rescale” and enter that number (e.g. 0.94) 

14. “OK” 

15. Open the newly sliced Analyze file 

16. Now we need the scan in the correct orientation; that , bottom left should be axial, top 

left should be coronal and top right should be sagittal (nose pointing to the right of the 

screen). To do this: 

17. Which orientation is currently displayed when you select Axial (horizontal)? E.g. if 

sagittal appears with nose to the right, then do the following: 

18. File → Save As → change ‘axial’ to ‘sagittal right’, then select “Save Intel” 

19. “OK” 

20. Note: need to close MRIcro at this stage, and then reopen it 

21. If you need to normalize, then you will need to do the following  

22. Reorientate the scan parallel to the AC-PC, and 

23. Set the AC as 0,0,0 in the “Origin” column (as in Figure 2) 
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Figure 2. MRIcro interface. Red arrow indicates the column where you reset the AC to be 

0,0,0 

 

24. Save As → Save Intel  
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2. Steps to convert dicoms to Analyze format (.img + .hdr) with dcm2nii 

 

1. Install MRIcron (http://www.mccauslandcenter.sc.edu/mricro/mricron/install.html , 

“download the zipped archive”; Rorden et al., 2007). Note that the latest version of 

dcm2nii 9called dcm2niix) is within MRIcroGL (http://www.cabiatl.com/mricrogl/ ) 

2. Navigate to the following directory:  C:\Program Files (x86)\MRIcroN 

3. Right-click on the following file: dcm2niigui.exe 

4. Select “Create shortcut”. There will now be a link on the Desktop to this file 

5. Close that directory 

6. Double-click dcm2nii on the Desktop (or, if using MRIcroGL, select “Import” then 

“Convert DICOM to NIfTI”) 

7. Click on the “output format” and change it to the first option (Figure 3), “SPM2 (Analyze 

hdr/img)” 

 

 
 

Figure 3. The DICOM to NIfTI GUI 

 

8. Navigate to the directory where the dicoms are 

9. Drag the folder of dicoms into the DICOM to NIfTI converter window 

10. In a few second the dicoms will be converted to Analyze format and reorientated (if 

required) 

 

 

 

 

 

  

http://www.mccauslandcenter.sc.edu/mricro/mricron/install.html
http://www.cabiatl.com/mricrogl/
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3. MRIconvert 

MRIconvert is an easy-to-use medical image file conversion utility that converts DICOM files 

to NIfTI 1.1, FSL NIfTI, Analyze 7.5 , SPM99/Analyze, BrainVoyager, and MetaImage volume 

formats. MRIConvert 2.0 is also good for .nii output, Analyze 7.5 output, and automatic 

generation of diffusion gradient files for Siemens Syngo scanners, Philips, and some GE 

scanners. It can be installed onto Windows, Mac, or Linux operating systems. 

 

4. SPIN to convert a directory of DICOMS containing different sequences (series) 

1. Open SPIN 

2. File → Sort DICOM and convert 

3. A new window opens (Figure 22). Click on the Browse button and navigate to your folder 

that contains all of the DICOMS 

4. Click “OK”. Within a few seconds all of the DICOMS will have been sorted into their 

respective directories, and the names of the directories will be based upon the name of 

the sequence (series). 

 

Figure 4. Sorting Dicom files using SPIN. 

DTIstudio also has a module to do this. 
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5. DICOMsort to convert a directory of DICOMS containing different sequences (series) 

1. Open DICOMsort software (Figure 23) 

2. Click the “Browse” button and navigate to your DICOM folder 

3. The values contained in the DICOM header should populate the “DICOM properties” field. 

 

Figure 5. DICOMsort user interface. 

4. Choose the values that you wish to sort by moving them from the “DICOM Properties” 

field to the “Properties to use” field (Figure 24). The series description is there by default. 

Note: If you choose multiple values to sort, the one at the top of the “Properties to Use” 

field will be the top-level folder followed by the lower items in subfolders. See figure below 

for an example of the folder structure that results from the values chosen 
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Figure 6. DICOM properties in DICOMsort. 

5. Before sorting the images click on “File”, then “Preferences”, then “Filename Format” 

and check the “Keep Original Filename”. (This ensures that other programs, such as 

FreeSurfer, don’t have difficulty reading the files).  

6. If you wish to anonymize the data then check the “Anonymize Data” button. Then “File”, 

then “Preferences”, then click the “Anonymizing Fields” button and choose the values that 

you wish to anonymize. 

7. Click “Sort Images”. 

Another good program to anonymize dicoms is DicomAnonym, which runs directly from 

the .exe file. 
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6. Preparing a T1-weighted scan for MiniBIRD stereotaxy 

1. Convert slice-by-slice into a volume (i.e. scan.img and scan.hdr) 

2. ‘Import’ → ‘Conversion wizard’. ‘OK’. Select the very first slice (dicom) and then give the 

scan a new name. The dicoms in the directory will be converted into 2 new files: an 

Analyze format image (xxx.img) and a matching header file (xxx.hdr) 

3. Locate the new converted scan (‘File’ -> ‘Open Image’). Select the scan’s .img or .hdr 

and then Open 

4. Reorientate: ‘File’ → ‘Save As’… Then select ‘Format’ → ‘Sagittal Left’, then ‘Save [Intel]’; 

give it a new name, and Save it. Exit MRIcro, wait a few seconds, then open it up again, 

and load this most recent scan (that has had ‘Sagittal Left’ applied to it) 

5. ‘File’ → ‘Save As’… Then select ‘Format’ → ‘Axial Down’, then ‘Save [Intel]’; give it a new 

name, and save it. Exit MRIcro, wait a few seconds, then open it up again, and load this 

most recent scan (that has had ‘Sagittal Left’ and ‘Axial Down’ applied to it) 

6. Convert from non-isotropic (anisotropic) to isotropic:  ‘Etc’ → ‘Convert anisotropic 

image to isotropic’, give it a new name and ‘Save’ 

7. Reslice voxels to 1mm3 : ‘Etc’ → ‘Rescale’. Enter the voxel dimension (see the ‘Size(mm)’ 

box) and make sure the ‘Output Size (mm)’ reads 1.00 x 1.00 1.00. 

8. Clip high and low: ‘File’ → ‘Save As’, now increase the values of the ‘Clip high’ and Clip 

low’ values until the red lines above and below the T1 scan (it should be displayed from 

sagittal by default) are slightly above the skull and just below the bottom of the 

cerebellum. Then select ‘Save [Intel]’, give the scan a new name, and Save. You should 

now have a saved scan that has 1mm3 isotropic voxels and clipped to only include the 

brain stem until slightly above the skull 

9. Extract the brain (include CSF beneath the inner table) – the so-called “BET” process 

(Brain Extraction Tool): ‘Etc’ → ‘Skull strip image using BET’, then ‘Go’, then give the 

scan a new name, and Save. A smaller black box will appear as iterations occur on the 

scan – this should take around 10 to 20 seconds to complete, and then the skull stripped 

scan will appear in the MRIcro window from 3 orientations. If only brain and no skull is 

present then BET worked well; if not, you need to reClip the scan (Step 5; so that less 

skull is present) and then try BET again 

Then: Normalize the scan using SPM 

1. Open SPM97 

2. Using a browser (e.g. My Computer), browse to the location of the scan to be 

normalized (i.e. the scan above that still has the skull) and have that screen open on the 

right-side of the screen 

3. In SPM97, ‘File’ → ‘New’ → Normalization 

4. The next screen (‘New spatial normalization’) presents default values of 1 subject and 

‘New document’. Just select ‘OK’ 
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5. Click on the + sign next to Subject 1, and ‘Template’, ‘Image to estimate parameters’ and 

‘Images to normalize appear’. Click on the + sign next to ‘Template’, and another layer 

will appear that states something like ‘C:\SPM96\Templates\PET.hdr’ – you need to 

change the word PET with T1 – do this by clicking on that line of text until it turns dark 

blue, and then replace PET with T1 

6. Click on the scan.hdr from the My Computer and drag it over the ‘Image to estimate 

parameters’, and then again click the scan from the My Computer and drag it over the 

‘Images to normalize 

7. ‘Calculate’ → ‘Settings’ 

8. Click on the tab that states ‘Parameter estimation’, and change ‘Number of nonlinear 

iterations’ to none, and ‘Number of basis functions’ to none. 

9. Click on the tab that states ‘Reslicing, and change ‘’Voxel size’ from 2 2 2 to 1 1 1, and 

‘Bounding box’ from MNI to ‘Template’ 

10. ‘OK’ 

11. ‘Calculate’ → ‘Start’ 

12. After around 10 to 20 seconds the scan will be normalized, but it has to be converted to 

another format so that you can open it in MRIcro 

13. Close SPM97 (you don’t need to save changes), open My Computer and locate the 

normalized scan: it will begin with an ‘n’ by default. Double-click on the scan and it will 

open in MRIcro. Once it is open, save it as a new name (‘File’ → Save As’, ‘Save [Intel]’), 

and it will be saved in the Analyze format that can be opened in MRIcro 

Or, if you have Matlab, use a newer version of SPM (e.g. SPM12) and utilise its normalization 

feature. 

The scan preparation process outlined above can also be used in conjunction with the 

trakSTAR device (updated version of miniBIRD).  
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7. Using the Ascension® MiniBIRD (Flock of Birds) for stereotaxic coregistration of MRI-to-
head-and-brain 

You will need to find at least 5 anatomic landmarks. 

1. Start MRIcro, and make sure the 'Yoke' and 'XBars' controls are checked [outlined in 
purple on the picture to the right]. It is generally easiest to find landmarks in the 
'projection' view that shows the Axial, Sagittal and Coronal views simultaneously 
[click on the 3D-cube button outlined in blue in Figure 4; Note that different 
versions of MRIcro will have different button arrangements] 

2.  
 

 
 

Figure 7. GUI for MRIcro for MRIreg. 

 
3. Load the MRI scan and find your landmarks (regions that you can identify on both 

the MRI scan as well as the individual's head [e.g. bones, nose, ears, etc]). If there 
are any anatomical regions of the brain you wish to locate (e.g. the motor hand 
area), you will also want to work out these coordinates. For all the landmarks, you 
will want to know where they appear in the X,Y and Z coordinates (outlined in 
green) 

4. Start the MRIreg software 
5. There are a few bugs in the software, so make sure to do the following: 

 

i) Select: Tracker (one of the pull-down menus), then “Fastrak”, then change it back to 
MiniBIRD (i.e. again, select “Tracker” then select “Flock of Birds/Minibird”) 

ii) A message will then appear on the screen. At this stage, turn the MiniBIRD switch (on the 
front of the unit) to 'STBY', then count 5 seconds in your head, and then switch it back to 
‘FLY’. If your Bird is connected correctly, the XYZ position of the bird sensor should appear 
(after a few seconds) at the bottom-right of the MRIreg window (e.g. 'FOB -742 139 892'); 
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this value should change when the Bird sensor is moved. If this does not work, try adjusting 
the serial-port speed (the 'FOB' menu allows you to choose a speed between 9600 and 
57600 baud, as well as letting you select either a miniBIRD or Fastrak system).  

5. You are now ready to add in coordinates to MRIreg. At this point, MRIcro should 
be displaying the MRI scan, and MRIreg should be displaying the position of the bird sensor 
(at the bottom right of the window) and the MRI scan coordinates (at the bottom left) 

 

Step 1: Calibration  

1. With MRIcro, click on the projection view to select an anatomical position. (You 
want to select the location where the sensor will be, e.g. instead of the tip of the 
nose, select a few millimetres anterior to the tip). 

2. Move the magnet sensor to the location displayed in MRIcro (Figure 5). 
3. Press the MRIreg '+' button (or press F1). A new spreadsheet row appears in 

MRIreg, showing the MRI position (left) and the corresponding magnet position 
(right). 

4. Repeat steps 1-3 until you have entered all of your anatomical landmarks. You must 
enter at least 5 positions, more positions give better accuracy during magnet 
tracking. Pick well-separated points (e.g. select regions on the face, the ears, the 
back of the head and the top of the head; instead of only points on the face). 

 

 

Figure 8. MRIreg and MRIcro on one screen. 
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Step 2. Magnet Tracking  

1. Once you have entered all of your anatomical landmarks in step one, we want to 
check the accuracy of the registration process. To do this: select “Mode” (one of the 
pull-down menus), and select “Track”. Now when the MiniBIRD magnetic wand 
moves, the red cross-bars in MRIcro should move as well 

Example: If you wanted to locate the left DLPFC the Talairach co-ordinates are -45,45,35 

(or 45,45,35 for the right), which is on the border of the anterior and middle thirds of the 

middle frontal gyrus. 

 

 

As before, this process can also be used in conjunction with the trakSTAR device (updated 

version of miniBIRD). Based on our experience, we suggest using the serial port connection 

(no drivers required) rather than the USB connection when using trakSTAR with MRIreg. 
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8. How to locate the DLPFC (F3 or F4) without an MRI brain scan 

 

Option A. International 10-20 system 

 

Modified Combinatorial Nomenclature (MCN). This MCN system uses 1, 3, 5, 7, 9 for the left 

hemisphere which represents 10%, 20%, 30%, 40%, 50% of the inion-to-nasion distance 

respectively (Figure 6). 

 

 

 

Figure 9. The international 10-20 system seen from (A) left and (B) above the head. A=Ear 

lobe, C=central, Pg=nasopharyngeal, P=parietal, F=frontal, Fp=frontal polar, O=occipital. (C) 

Location and nomenclature of the intermediate 10% electrodes, as standardized by the 

American Electroencephalographic Society. (Redrawn from Lagerlund, 1993). 

 

 

http://butler.cc.tut.fi/~malmivuo/bem/bembook/13/13x/1302ax.htm
http://butler.cc.tut.fi/~malmivuo/bem/bembook/13/13x/1302cx.htm
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Option B. “Beam” software (Beam et al., 2009). 

1. Measure distance from Tragus to Tragus: make sure it passes through the vertex 
(AKA CZ in the 10-20 system). Enter this distance into the software 

2. Measure distance from nasion to inion: make sure it passes through the vertex. 
Enter this distance into the software 

3. Measure head circumference (above the brow-line); this should measure the largest 
diameter. Enter this distance into the software 

4. Click the “Calculate” button and 2 measurements will appear: “Distance along 
circumference from midline (X)” and “Distance from Vertex in CM (Y)”. Use your tape 
measure and mark the Xcm distance starting from the midline at the brow-line and 
mark the spot with a texta, then measure the Ycm distance from the vertex: it should 
end up at the same spot as X 

 

Figure 10 illustrates an example of locating the left DLPFC. 

 

Figure 10. Beam software interface to locate the left DLPFC.  
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9. Example of tracing an ROI in MRIcro. In this case, the caudate. 

The brain MRI scan that you will use in this example (called “ch2”) is the ‘smoothed’ MNI 

(Montreal Neurological Institute) template (the 27 averages of a ‘normal’ adult brain). This 

is included in the MRIcro package. This scan is also included with only the brain (i.e. it has 

undergone the Brain Extraction Tool (BET) process), hence, no skull appears on it (called 

“ch2bet”). This scan will be used for task (1) so as to allow for more visually representative 

3D renderings. 

 

Task 1: Estimate the volume of the left caudate by manually tracing it using MRIcro 

1. Load T1-weighted volume (File → Open File → ch2bet.hdr) 

2. Display axial (transverse) sections (1st icon on the left in the “Slice Viewer” toolbar) 

3. Select the “Pen for drawing object outline” icon (2nd icon from the left in the lower row 

in the Region of Interest toolbar) 

4. Move to slice 97 and begin outlining the superior portion of the caudate. That is, outline 

this ROI with the left mouse button and then right click inside the outline to flood-fill it. 

If the entire screen is flood-filled, then the outline has not been closed (i.e. the border 

has a voxel not traced). If this happens, simply click on the “Undo last drawing” icon (3rd 

icon from the left on the upper row of the Region of Interest toolbar [it looks like a 

yellow pencil with a black tip on a 45 degree angle). Note: this undo feature can only be 

used to undo the previous drawing (that is, you cannot undo 2 or more steps) 

5. Continue to outline this ROI (i.e. the caudate) on each axial slice (from superior to 

inferior) until the most inferior slice is outlined for the ROI around slice 57; any more 

inferior [lower] does not contain left-side caudate. You can move from slice-to-slice with 

the Up and Down arrows on the keyboard, or by changing the number that appears in 

the Slice Viewer, or, you can simply use the wheel on the mouse between the left and 

right buttons) 

6. Click on the “View projection” icon (4th icon from the left in the “Slice Viewer” toolbar). 

The scan from the midpoint (i.e. the middle slice) of all 3 orientations (axial, sagittal, 

coronal) should now be displayed simultaneously. The traced ROI should also appear on 

the coronal (upper left) and axial (lower left) slices. Left clicking on any part of a slice in 

any of the orientations will automatically change the slice number of the other 2 slice 

orientations to match the voxel that you have just clicked. For example, clicking in the 

middle of a large part of the caudate from coronal from slice 126 (you can change the 

individual slice numbers from any of the 3 orientations whilst they are still displayed 

simultaneously by altering the slice numbers x,y,z, just below the Slice Viewer toolbar. 

Using “View projection” helps to verify that you have outlined (traced) the structure 

correctly. That is, it helps to make sure that you have outlined the correct ROI; in this 

case, it should all be gray matter, hence, if any white matter is traced from any 

projection then those voxels will need to be erased. Erasing voxels (only from a single 
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orientation, not from View Projection”: Go to the slice where part of the ROI needs to be 

deleted, then move the cursor over the voxel that you wish to remove, then hold down 

the “Enter” key on the keyboard whilst also holding down the left mouse button. 

Clicking on the right mouse button whilst holding down the “Enter” key will erase the 

entire ROI on that slice. If you do this by accident, simply click on the “Undo last drawing” 

icon 

7. Once you are satisfied that your tracing of this ROI is accurate, “Save the ROI” (4th icon 

from the left on the upper row of the Region of Interest toolbar, or, from the ROI pull-

down menu) as “ch2bet_right_caudate.roi” 

8. Calculate the volume of the ROI: the volume appears in the lower left of the “Region of 

Interest” toolbar when the ROI is initially opened. So, you need to “Open ROIs”, select 

on the ROI that you have just saved (i.e. ch2bet_right_caudate.roi), and click “OK”. 

Important: don’t move the mouse because as soon as you move the mouse the volume 

displayed disappears and is replaced by the co-ordinates of the cursor!! 

9. Write down the volume displayed (which should be around 4.5-5.0cc) 

 

Task 2: Open the “aal” image that is included in the MRIcro directory 

(C:/ProgramFiles/MRIcro/). Move the mouse to the Talairach co-ordinates below and write 

down the name of the ROI at these co-ordinates, including whether each set of x,y,z co-

ordinates represent the ROI on the right or left of the brain in Talairach space. 

 

Table 1. Example of names of ROIs that represent Talairach co-ordinates. 

ROI 
Number 

Talairach co-ordinate Right or Left Name of ROI 

x y z 

1 -49 6 39 L Precentral gyrus 

2 49 -54 32 R Angular gyrus 

3 30 -11 -17 R Hippocampus 

4 -8 -9 9 L Thalamus 

5 -8 18 -2 L Caudate 

6 48 18 -20 R Superior temporal gyrus 

7 -8 0 60 L Supplementary motor area 

8 -4 40 16 L Anterior cingulated gyrus 

9 -14 -65 -3 L Lingual gyrus 

10 20 3 1 R Globus pallidum 
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10. Manual tracing of a Region Of Interest (ROI) in Analyze® 

1. Double-click on the Analyze icon 
2. Click on the far left icon that looks like a truck (“Load As”) 
3. Click on the “File” button, and browse to the directory where the T1-weighted scan is 

located 
4. Select the header (.hdr) or image (.img) of the T1-weighted scan 
5. Click on the “Open” button (bottom right of Load As module), or double click the 

selected file in Step 4 
6. Click on the “Load” button (bottom left of Load As module). The brain scan will now load 
7. Click on the ROI icon (usually left of the EXIT icon on the far left of the tool bar [called a 

Powerbar]) 
8. The ROI module should now have opened 
9. Move to a slice where the brain is visible (e.g. middle slice). Alter the intensity 

(“Intensity” icon on the far right of the Powerbar [on the top of the screen]) so that the 
contrast between GM/WM/CSF is optimal. Note: the sliding bar of the Intensity setting is 
very sensitive, so it often quicker to enter the Intensity Max and Min values manually 
(once you have established then for one scan, the rest of the scans acquired with that 
sequence on that scanner should be set to the same (if not identical) intensity levels) 

10. Select the slice where you have chosen to begin tracing the ROI 
11. Select the “Trace” icon (on the left) and hold down the left mouse button at the first 

pixel. Whilst holding down the left mouse button, outline the ROI and then release the 
left mouse button. A number will appear inside the ROI tracing to represent that ROI. 

12. Name the ROI: View → Objects. Select the Object (named as its number) and name it as 
the Name of the ROI. E.g. left_hipp means Left Hippocampus 

13. Click on Done (lower right) 
14. Move to the next slice (+ key on the keyboard or with the “Arrow” on the Powerbar) and 

begin tracing the ROI on that slice. Repeat this until all slices have been traced for the 
ROI 

15. Save the traced ROI (File → Save Object Map) 
16. To begin tracing a new ROI, select “New” from the “objects to define” located at the 

lower right of the screen and repeat Steps 10 to 14 for further ROIs. 
 

 

Here is a link to the Analyze document that we contributed to which provides step-by-step 

instructions for manually segmenting the hippocampus from T1-weighted images: 

http://analyzedirect.com/documents/guides/hippocampal_volume_assessment.pdf  

 

 

 

 

http://analyzedirect.com/documents/guides/hippocampal_volume_assessment.pdf
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A visual guide of the conversion of .obj files to Analyze format: 

1. Use Analyze 

a. File -> Import/Export 

 

Figure 11. The Import/Export module in Analyze® 

b. Click on the ‘File-to-File button  

c. Select the object map to be modified (by using the ‘File’ button to browse) 

 

Figure 12. The File-to-File option in the Import/Export module in Analyze® 

d. Rename the output file 

e. Assign the output file the ‘AnalyzeImage 7.5’ file format. IMPORTANT: A bug in this 

module is as follows: if you Assign the output file format BEFORE naming the new output file 

then this entire file-to-file process will NOT work! SO, BE SURE TO CARRY OUT STEP D. 

BEFORE STEP E AND F. 

f. Click on the ‘Convert’ button 

g. Click on the ‘Done’ button  
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11. Steps for 3D rendering in ITK-SNAP of ROI (object maps) traced in Analyze 
 

1. Open Analyze 

2. File → Import/Export 

3. File-to-File icon (far left icon) 

4. Browse for the tracing (object map) to be converted, and select it 

5. Change output name to something relevant 

6. Change new format to “Analyze 7.5” 

7. Convert 

8. Done 

9. Open ITK-SNAP (Yushkevich et al., 2006) 

10. Open T1-weighted image (.hdr) as “Load Data/Greyscale Image” 

11. Open the newly converted Analyze 7.5 format object map (.img) as “Load 

Data/Segmentation Data” 

12. Then fiddle with label colours, transparency, and intensity (Options , Display curves, 

then hold-and-move the 2 dots along the graph’s diagonal line) 

13. NOTE: you must change the voxel dimensions of the Analyze 7.5 format tracing; USE 

MRIcro → note that voxels are 0 x 0 x 0 mm in MRIcro → change these number to 1.00 x 

1.00 x 1.00mm (NOTE: figure below) so that they match the T1-weighted scan voxel 

dimensions 

 

Figure 13. Fields that must be changed to match voxel dimensions of the T1-weighted scan. 
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14. 12) “Update mesh” (bottom of screen) 

 
Figure 14. The “update mesh” button in ITK-SNAP 

 

15. Then fiddle with label colours, transparency, and intensity (Options , Display curves, 

then hold-and-move the 2 dots along the graph’s diagonal line) 

16. To view the 3D rendering in its own screen, press “+” at the bottom of the screen, as 

follows: 

 
 

Figure 15. Maximizing the 3D-rendered ROI in INTK-SNAP. 

 

 
 

Figure 16. An example of a left Heschl gyrus traced in Analyze and then 3D-rendered in 

ITK-SNAP.  
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12. Inter-rater reliability 

Inter-rater reliability = ((Rater A – Rater B) / ((Rater A + Rater B) / 2)) * 100 

In other words, the percentage difference between the Raters. 

The other way to calculate inter-rater reliability is in SPSS with “intraclass correlation”. The 

reference is Shrout & Fleiss (1979). Or, simply calculate “kappa”. 
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13. FreeSurfer 

FreeSurfer (Fischl et al., 1999) is a great program for conducting group T1-weighted 

(structural) analyses. It calculates volume, thickness, area and curvature of dozens of ROIs. 

Apart from the FreeSurfer forum and wiki, an excellent FreeSurfer resource is located here: 

http://vitallongevity.utdallas.edu/cnl/wp-

content/uploads/2015/10/FREESURFER_GUIDE_CNL_2015Oct.pdf . To process a scan 

through FreeSurfer on Linux: 

1. Download FreeSurfer (latest version): note whether your computer is 32-bit or 64-bit 

2. Copy it to the desktop of your Linux operating system 

3. Open a terminal 

4. Type the following: sudo mv freesurfer-<version> /usr/local/ 

5. Extract the freeSurfer file by typing the following (from /usr/local/): 

sudo tar xzvf freesurfer-<version>-full.tar.gz 

6. Copy your .license into the /usr/local/freesurfer directory by typing: 

sudo mv .license /usr/local/freesurfer 

7. Download and install tcsh by either downloading and installing online by: 

a) typing the following: sudo apt-get install tcsh 

or 

b) Download it from another computer and then copy it across to the desktop of your Linux 

operating systems and type in the following from a terminal (from ~/Desktop): 

sudo dpkg –i tcsh 

8. Then modify the tcsh file so that the following 2 lines appear: 

setenv FREESURFER_HOME <freesurfer_installation_directory>/freesurfer 

(which in our case would be: setenv FREESURFER_HOME /usr/local/freesurfer) 

source $FREESURFER_HOME/SetUpFreeSurfer.csh 

If done correctly then those 2 lines should load when you type in ‘tcsh’ from a terminal 

9. Give permission to write in the /usr/local/freesurfer/subjects/ directory by typing: 

sudo chmod 777 /usr/local/freesurfer/subjects 

http://vitallongevity.utdallas.edu/cnl/wp-content/uploads/2015/10/FREESURFER_GUIDE_CNL_2015Oct.pdf
http://vitallongevity.utdallas.edu/cnl/wp-content/uploads/2015/10/FREESURFER_GUIDE_CNL_2015Oct.pdf
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10. Test the installation by typing in: tkmedit bert orig.mgz (to see an example) and then 

tksurfer bert rh pial (to see an example). Have a play and then close the program. 

11. Copy a subject’s dicoms into a directory under the directory 

/usr/local/freesurfer/subjects/ 

12. Let’s say the subjects is called ‘control1’ and the first dicom is called IM1.dcm 

13. From a terminal in the /usr/local/freesurfer/subjects/ directory type in 1 single 

command to execute all 31 steps of Freesurfer: 

recon-all -s control1new -i control1/IM1.dcm -all 

Note: for Step 8: cd (to make sure you are in your home directory). Note as well that if you 

have scans with higher resolution than 1.00 isotropic, add the following flag to the end of 

the recon-all command: -highres 

It’s also a good idea to include T2 data to optimise the pial segmentation. To perform recon-

all to incorporate the T2 data: 

recon-all -s <SUBJECT_ID> -i <SUBJECT_ID>/T1/IM1.dcm -T2 <SUBJECT_ID>/T2/IM1.dcm -

all -T2pial 

• In around 7 to 24 hours (depending upon the scan contrast and computer resources) the 

scan will be fully processed. It takes a long time because 31 processes are occurring for 

each hemisphere of data 

• FreeSurfer is multi-threaded, so it can use all of the CPU cores you have available (To run 

recon-all with multiple cores, type this is in at the end of the command: 

-openmp number_of_cores    . For example, if your CPU has 8 cores, then: -openmp 8 

 

14. After each T1-weighted scan has been processed via recon-all, you can view the results 

by typing in the following (as a single command line): 

 

tkmedit nameofscan norm.mgz -segmentation aseg.mgz 

$FREESURFER_HOME/FreeSurferColorLUT.txt 

 

 

15. To view the 3D rendering, type in the following: 

 

tksurfer nameofscan rh pial 

 

(To look at the left hemisphere type tksurfer nameofscan lh pial) 
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Note: to visualize only specific gyri using tksurfer; follow these instructions (contributed by 

Phillip Law): 

 

1. Load existing label: File -> Label -> Load Label -> Browse -> <select label file> (e.g., 

lh.aparc.annot for left hemisphere or rh.aparc.annot for right hemisphere) -> Press ‘OK’ -> 

Press ‘OK’. 

2. Select and mark ROI(s): Left click on ROI and press Mark Label icon ( ; marked ROI will 

turn white). 

• To select another ROI, repeat step 2. 

3. Create marked label from selected ROI(s): Click New Label from Marked icon ( ). 

4. Save custom marked label: File -> Label -> Save Selected Label -> <enter filename> -> Press 

‘OK’. 

5. Restart FreeSurfer 

6. Load custom marked label: File -> Label -> Load Label -> Browse -> <select label saved in step 

4> -> Press ‘OK’ -> Press ‘OK’. 

7. Change color of marked label: Click Change label color icon ( ). 

 

 

16. For group analysis, you then need to smooth the data via the “qcache” command. That 

is, for each scan, type in the following: 

recon-all -s control1new -qcache 

• The -qcache takes around 10 to 30 minutes for each scan, depending upon how many 

scans you are simultaneously processing, and the available computer resources 

• After each scan has finished the qcache procedure, you need to create a “plain text” 

document that is the matrix. For example,  

 

Fsid diagnosis sex age 

Id1 control f 20 

Id2 control m 24 

Id3 clinical m 21 

Id4 clinical f 24 

 

• Then save it as something like “qdec_table” (in plain text format) 
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• Next, you need to make a “diagnosis” plain text file, something like: 

 

control 

clinical 

• Then save it as “diagnosis.levels” (in plain text format) 

• Now make another file for the “sex” column, as follows: 

 

 

m 

f 

And save it as “sex.levels” (in plain text format). 

• Now run the FreeSurfer GLM program called “qdec”: Type in “qdec” 

• A GUI (graphical user interface) will now open (Figure 17). 

 

 

Figure 17. The QDEC GUI. 

• Open the matrix table (the .dat file you made that contains the matrix data, the one 

called “qdec_table.dat”) 

• Then, click on the “Generate Stats Data Tables”. This will import all of the data pulled 

from the scans’ “surf” directories included in the qdec_table file 
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• Select the pull-down menu from that tab (which now states “none selected”) and select 

“aseg.volume” (Figure 18). 

 

 

Figure 18. The QDEC GUI with a stats table loaded. 

• Select the “Design” tab, and change “thickness” to be “volume” (Figure 19). 

 

 

Figure 19. The Design section of QDEC. 
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• Click on the “diagnosis” option in the “Discrete (Fixed Factors)” window (Figure 20). 

 

 

Figure 20. The Discrete (Fixed Factors) section of QDEC. 

• Click on the “Analyze” button at the bottom. You will see the progress bar (in blue) 

moving in the bottom right of the screen from 0% to 100% (can take a few moments to 

process) 

• A new window will now appear called “Display” that shows the “inflated” brain in 3D 

• Select the second option in the left window (e.g. “Does the average volume differ 

between control and clinical?”) 

• The uncorrected results (vertices) will now appear over the inflated brain (Figure 21). To 

visualise the pial surface, click on “pial” (near the top of the Display tab) or “white” to 

see white matter 
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Figure 21. Uncorrected results superimposed over the inflated brain in QDEC. 

 

• To analyze results for multiple-comparisons, used either FDR (false discovery rate), or 

the less stringent Monte Carlo Null-Z simulation: 

• Change the default Threshold of 2.0 (0.01) to 1.3 (0.05) from the drop-down menu next 

to the word “Threshold” 

• Click on the “Run” button 

• Within a few seconds, the multiple-comparisons results will be superimposed in 3D over 

the inflated brain (Figure 22). In the example below, there are significant differences 

over the left superior parietal lobe, as seen in the terminal (Figure 23) which also states 

the significance values for that cluster as well as its Talairach co-ordinates and size (in 

mm2). Note that the significance values in FreeSurfer are stated as -log(10). As a guide, a 

value of 2.0 is equivalent to p=0.01, and 1.3 is equivalent to p=0.05. 
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Figure 22. Corrected results superimposed over the inflated brain in QDEC. 

 

 

Figure 23. QDEC statistics output are displayed in the terminal. 

 

• To process thickness, area, or curvature analysis, navigate back to the “Subjects” tab, 

drop down the pull-down menu, and select the type of analysis you want to investigate. 

Then, navigate to the “Design” tab and change “volume” to what you want to look at, 

then “Analyze”. Note that the left hemisphere was processed first, so you need to select 

the right hemisphere if you want to look for significant differences in the right 

hemisphere 

• Note that you can also use covariates or nuisance factors (in the “Design” tab) by clicking 

on them 
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NOTE: To change the working directory, for example, to a directory called “mydirectory”, 

type in the following BEFORE typing in tcsh: 

export SUBJECTS_DIR=/usr/local/freesurfer/subjects/mydirectory 

NOTE: when running the recon-all command you must have the fsaverage subdirectory in 

your working directory, however in recent versions (e.g. 6.0) this is not required. 

How to create volume and thickness statistics of BA regions and V1 and V2 (primary and 

secondary visual areas) 

First extract the data from the FreeSurfer output (this may take a few hours per subject): 

recon-all -s control1new -qcache 

Then extract the thickness data into a text file (replace “thickness” with “volume” for 

volumetrics): 

aparcstats2table --hemi lh --subjects  subject1 subject2 subject3 --parc BA --meas 

thickness --tablefile ba_v1_v2_lh_thickness.txt 

aparcstats2table --hemi rh --subjects  subject1 subject2 subject3 --parc BA --meas 

thickness --tablefile ba_v1_v2_rh_thickness.txt 

How to export the data from FreeSurfer into SPSS 

1. After you have conducted a QDEC analysis, a new directory will have been created in the 

“qdec” directory called “stats_tables”. Navigate to this directory 

2. Copy all of the files in the directory (they will all have a .dat extension) onto a Windows 

computer 

3. Open MS Excel 

4. Select on a .dat file (although it may appear with a .stats extension) and then open it 

(you may have to select “delimited”, then “tab”) 

5. Save the file in Excel 97-2003 format 

6. Close Excel 

7. Open SPSS 

8. Change the option in the navigation window to show “All files” 

9. Select the Excel file which you have just saved 

10. The Excel file will now open in SPSS 

11. Save As 

12. Complete this process for all of the .dat files 

13. Once all .dat files have been converted to SPSS format, merge them (using the merge 

feature in SPSS: Data → Merge Files → Add variables) 
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How to extract a ROI from FreeSurfer output and use it as a seed for tractography in MRtrix 

mri_label2vol --seg aparc.a2009s+aseg.mgz --temp fa_coreg.nii --o aparc.a2009s+aseg-in-

fa.mgz --regheader aparc.a2009s+aseg.mgz 

 

Note: Don’t confine to 'interp nearest', and the fa_coreg is the FA map converted to .nii. 

 

A simple way to convert an ROI from FreeSurfer (e.g. caudal anterior cingulate) into nii 

format is as follows: 

 

mrconvert rh.caudalanteriorcingulate.nii.gz rh.caudalanteriorcingulate.mif 

 

How to import a volume-based mask into surface space to extract the thickness values in 

FreeSurfer (Contributed by Jonatan Ottino-González) 

 

(1) to check if the mask is in the correct space 

 

tkmedit -f $FSL_DIR/data/standard/MNI152_T1_2mm.nii.gz -overlay 

/path/to/mask/mask.nii.gz -fthresh 0.5 

 

(2) cd to $SUBJECTS_DIR/fsaverage/surf 

 

(3) register the MNI152 template to the 'fsaverage' space 

 

fslregister --s fsaverage --mov $FSL_DIR/data/standard/MNI152_T1_2mm.nii.gz --reg 

MNI152_to_fsaverage.dat 

 

(4) Check if everything's ok  

 

tkmedit fsaverage T1.mgz -overlay /path/to/mask/mask.nii.gz -overlay-reg 

MNI152_to_fsaverage.dat -fthresh 0.5 -surface lh.white -aux-surface rh.white 

 

(5) Transform the volume-ROI into a surface-ROI 

 

mri_vol2surf --mov /path/to/mask/mask.nii.gz --reg MNI152_to_fsaverage.dat --projdist-

max 0 1 0.1 --interp nearest --hemi lh --out lh.surface_mask.mgh 

 

(6) Quality check 

 

tksurfer fsaverage lh inflated -overlay lh.surface_mask.mgh -fthresh 0.5 
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(7) Convert surface (*.mgh) to a .label file 

 

mri_vol2label --i lh.surface_mask.mgh --id 1 --surf fsaverage lh inflated --l 

lh.surface_mask.label 

 

Note that the last step can cause problems because the mri_vol2label command (now called 

cor2label) needs an ID number in a COR-file, so the --surf flag saves you on this one. 

FS hippocampal subfields 

To perform hippocampal subfield segmentation, add the following flag to the end of your 

recon-all command: 

-hippo-subfields 

sudo gedit .tcshrc 

From version 5.3, FreeSurfer can segment hippocampal subfields. However, always try to 

use the most recent version of FreeSurfer as each update contains more accurate 

segmentation and additional features. At the moment, FreeSurfer 6 is the most recent. The 

updated feature of this version is the enhanced accuracy of the hippocampal subfield 

segmentations (instead of -hippo-subfields, on Version 6 you add -hippocampal-subfields-

T1). You can have multiple versions of FreeSurfer installed on the same computer, just make 

sure to change the path to point to the version you want to use. Also, when using version 6, 

you can add the -qcache flag to the original recon-all command; that is, you no longer have 

to run recon-all  -all and then run recon-all -qcache afterwards (you can now do it all in one 

command). Note that the hippocampal calculations can require around 10GB of RAM per 

scan. 

 

You can run the hippocampal subfield segmentation routine on previously processed recon-

all data, but they must have been processed using version 5.3 and above. The results are 

contained in each subject’s /mri/ directory in files named “lh.hippoSfVolumes-T1.v10.txt” 

and “rh.hippoSfVolumes-T1.v10.txt”. To gather the hippocampal subfield volumes from all 

subjects, type in: quantifyHippocampalSubfields.sh <T1>-<analysisID> <output_file> 

<OPTIONAL_subject_directory> (note that the third [last] argument is not necessary if the 

environment variable SUBJECTS_DIR has been defined). 

 

IMPORTANT: To run the hippocampal subfield segmentation for version 6 (“dev”), you 

need to download and install Matlab Runtime: 

LINUX: 

 cd /usr/local/freesurfer 
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curl 

"http://surfer.nmr.mgh.harvard.edu/fswiki/MatlabRuntime?action=AttachFile&do=get&target=runti

me2012bLinux.tar.gz" -o "runtime2012b.tar.gz" 

tar xvf runtime2012b.tar.gz 

 MAC: 

 cd /usr/local/freesurfer 

curl 

"http://surfer.nmr.mgh.harvard.edu/fswiki/MatlabRuntime?action=AttachFile&do=get&target=runti

me2012bMAC.tar.gz" -o "runtime2012b.tar.gz" 

tar xvf runtime2012b.tar.gz 

Now all you need is to append the flag -hippocampal-subfields-T1 to your recon-all command. For 

example, to analyze your subject "bert", you would type: 

recon-all -all -s bert -hippocampal-subfields-T1  

Or, if Bert has already undergone the FreeSurfer pipeline (recon-all -all), you can just run: 

recon-all -s bert -hippocampal-subfields-T1 

 

Contrast-to-noise ratio (CNR) 

 

To calculate the contrast-to-noise ratio (CNR) of a T1-weighted scan, type in the following: 

mri_cnr "$SUBJECTS_DIR"/surf "$SUBJECTS_DIR"/mri/norm.mgz 

 

Signal-to-noise-ratio (SNR) 

 

To calculate SNR: 

wm-anat-snr --s "$SUBJECTS_DIR"/subjectID 

 

 

Euler 

To extract the Euler statistics for your scans (i.e. 2 - 2*number of surface defects) before 

being fixed (before any smoothing operations are applied and estimates the topological 

correctness of one’s surface model), type in the following: 

grep - A 2 "Computing euler" “$SUBJECTS_DIR ”/scripts/recon-all.log 
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If that doesn’t work, then the words “Computing euler” are not in the all.log files. So, leave 

out the word “Computing” and just type in: 

grep - A 2 "euler" “$SUBJECTS_DIR ”/scripts/recon-all.log 

To have no defects (holes, handles) is quite unusual; I have found that on average each scan 

has around 15 to 20 holes/handles (so the Euler values would be around -28 to -38). Chalavi 

et al. (2012) provides some normative data based on a set of scans. 

 

 

Viewing FreeSurfer hippocampal subfield output: Freeview 

 

The alternative FreeSurfer viewer is called Freeview and is very easy to use. 

 

For example, to open a subject’s T1-weighted scan and then superimpose the hippocampal 

subfields segmentations, type in: 

 

freeview 

 

• Select File → Load Volume (or use the Load button on the left toolbar) 

• Select the T1.mgz file in the subject’s “mri” directory 

• Open another volume (File → Load Volume, or use the Load button [green +]) 

• Select the left (or right) hippocampal segmentations i.e. lh.hippSfLabels-T1.v10.mgz 

• Change the Color Map (on the left toolbar) to “Lookup Table”. The hippocampal 

subfields will now appear as different colours. 

• Click the box “Show existing labels only” 

 

NOTE: If you encounter an error that states “error while loading shared libraries: 

libjpeg.so.62: cannot open shared object file: No such file or directory”, then run the 

following from a terminal (https://surfer.nmr.mgh.harvard.edu/fswiki/ReleaseNotes ): 

 

sudo apt-get install libjpeg62-dev 

https://surfer.nmr.mgh.harvard.edu/fswiki/ReleaseNotes
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Figure 24. A 3-dimensional rendering of hippocampal segmentation in freeview. 

 

• To render the subfields without the T1 scan in 3D, unclick the T1 scan (upper left), and 

then click “Show as isosurface in 3D view” 

• In the “Range” boxes, type in 203 and 226 (these are the subfield label numbers). Press 

Enter. 

• Select the 1x1 box (top toolbar) 

• Right-click anywhere on the 3D image and select Show Slice Frames (3D View), the 

frames will now be removed 

• Slide the mouse whilst holding down the right mouse button to zoom, the left button to 

rotate, and the middle button to move the object. 

• To generate a smoother rendering, slide the “Smooth iterations” bar to the right 

(maximum value is 20). 

Note: After loading the qdec.dat into Qdec and clicking on “Generate Stats Data Tables”, 

several .dat files containing, left and right volumes, thickness etc will be produced in the 

/qdec/stats folder. To merge all of those.dat files into one single file: 

paste -d lh*.dat > all_left.dat 

paste -d rh*.dat > all_right.dat 

paste -d aseg*.dat all_left.dat all_right.dat > all_subjects_output.dat 
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Registering the Freesurfer atlas to diffusion registration 

Change highlighted yellow (inputs) and blue (output file names) accordingly: 

  

# register freesurfer brain to diffusion b0 

bbregister --s [subject folder] --mov [nodif_eddy_brain.nii.gz] --init-fsl --dti --reg 

reg_FS2nodif.dat 

  

# apply to atlas 

mri_vol2vol --targ $fs_dir/aparc.a2009s+aseg.mgz --mov $mrtrix_dir/nodif_eddy_brain.nii.gz 

--inv --interp nearest --no-save-reg --reg reg_FS2nodif.dat --o 

$subject_project/aseg2nodif.mgz 

 

The second line will register any of the fs atlases to diffusion space. Just change 

the $fs_dir/aparc.a2009s+aseg.mgz to the hippocampal subfield atlas and apply the same 

reg. The output can then be separated into individual masks if you want to do that using 

mrcalc: 

 

mrcalc $subject_project/aseg2nodif.mgz -eq [individual subfield label ID] output 

 

If this produces an error when trying to extract individual subfields from the hippocampus, 

then try this: 

mri_convert hippocampus_reg_to_bzero.mgz hippocampus_reg_to_bzero.nii 

fslmaths hippocampus_reg_to_bzero.nii -uthr 206 -thr 206 left_CA1.nii 
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14. Protocol to process SWI/SWAN images from magnitude and phase data 

 

1. Use SPIN 

2. Process →MIP/SWI processing (Figure 24) 

3. Option 2 (MIP with Phase multiplication) 

4. Phase masking: use “positive” 

5. Select Phase (2nd dicom folder) 

6. Select Magnitude (1st dicom folder) 

7. Number of slices for each MIP: 1 

8. Number of multiplications: play with it, but default is 4 (watch for false positives if 

use a higher value) 

9. MIP prefix (=SWI image): change to a meaningful name 

10. High pass filter: 160 

11. Vertical slice: 160 

12. Note: reduce HP filter and Vertical slice (e.g. 64) to show “more” vasculature but will 

increase artefact 

 

 

 

Figure 25. Options within SPIN for processing SWI images from phase and magnitude data  
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15. FSL (Linux/MAC) 

FSL (Smith et al., 2004) includes a number of modules for T1-weighted and DTI analyses, 

although it can also be used for fMRI processing. Always make sure to download the most 

current version. If you encounter an error during installation that states something like fsl-

complete is available but not downloaded, just try another server. 

To install FSL in bash, type in the following (it is best to add this to the setup file): 

 

FSLDIR=/usr/local/fsl 

. ${FSLDIR}/etc/fslconf/fsl.sh      # note the space between the . and $ 

PATH=${FSLDIR}/bin:${PATH} 

export FSLDIR PATH 

 

Alternatively, you can download an automated installation script 

(http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FslInstallation ) 

 

After typing in “fsl” in the console a GUI will appear (Figure 25). 

 

Figure 26. The FSL GUI. 

 

http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FslInstallation
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BET (Brain extraction tool): This strips the skull and eyes from the scan to leave just brain. 

Very useful, very accurate, and very quick. Hint: If you T1-weighted scan has a lot of neck in 

it, consider clipping the scan to remove the neck by typing in the following: 

robustfov “name_of_t1_scan” 

FAST (Fully Automated Segmentation Tool): input your BET’ed T1-weighted scan, and after a 

few second the output will be GM, WM, and CSF, saved as separate images as well as 

volumetrics for each of these components. 

Some tips on settings and interpretation of FSL FAST output viewing in MRIcro 

 

Change the colour to HOT METAL 

 

Change the following intensity and contrast value  as  follows:  

Black = 0 

White = 4 

 

Colours for each component: 

TIS1 (WM) = orange 

TIS2 (GM) = red 

CSF = blue 

 

NOTE: There are MANY packages available to compute gray matter, white matter, and CSF 

volumes from T1-weighted scans, including FSL (FAST), SPM, FreeSurfer, and many more… 

 

Useful in dMRI processing: 

To flip gradients automatically in a bvec, for example the x-gradients, try this: 

cat bvec.bvec | awk ‘{ print -$1, $2, $3; }’ > new_bvec.txt  
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16. Tract-Based Spatial Statistics (TBSS) which is part of FSL 

 

For every subject’s DTI scan, you must complete the following pre-processing steps: 

1. Convert each scan to FSL 4D NIfTI nii format (via dcm2nii; this produces 3 files: a big 

data file (.nii) + a small .bvec file + a small .bval file; Figure 26) 

 

 

 
 

Figure 27. Use the correct option for converting dicoms to FSL (4D NIfTi nii) format. 

 

2. Eddy current correct the niifti scan by doing the following: 

3. Type in “fsl” 

4. Select “FDT diffusion” (Figure 27). 

5. Click on the drop-down box and select “Eddy current correction” 

 

 

 
 

Figure 28. The FDT GUI in FSL. 

 

6. Open the directory where your .nii file is and select it. The default output file will be 

called “data.nii.gz” 

Click “Go”. The eddy current correction takes at least 5 minutes to process, depending upon 

the number of directions and number of slices to be processed. After it has completed, click 

on the “OK” (in the “Done” box), then “Exit” on the FDT box. It is now known that the eddy 

in FSL versions before 5.0.9 may make the output worse. So, a new version of eddy was 

introduced in 5.0.9 which also produces a rotated bvec file. We strongly urge you to use 

version 5.0.9 (or newer). UPDATE: If you have downloaded the Neurodebian eddy patch 

(http://neuro.debian.net/pkgs/fsl-5.0-eddy-nonfree.html ), then eddy can only utilize one 

of your CPU cores. To make eddy much faster, you can download eddy_openmp (see Part 3 

http://neuro.debian.net/pkgs/fsl-5.0-eddy-nonfree.html
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of this Handbook) and then eddy will use as many cores as you have available. Just place 

eddy_openmp in the bin directory where your eddy is (to locate the directory, type in 

‘which eddy’), and then you can use it. Then, instead of typing in ‘eddy’, just type in 

‘eddy_openmp’. Make sure to give yourself permission to use this new file (sudo chmod 

775 eddy_openmp). 

7. Exit FSL 

8. In the terminal, navigate to the directory you are working with, and type in the following 

which will extract the first volume of your data (i.e. the b-zero [T2-weighted scan]) and 

labels it as nodif): 

9. fslroi data.nii.gz nodif 0 1 

10. bet nodif.nii.gz nodif_brain -m -f 0.3 (this command BETs the no diffusion (b=zero) scan 

and then masks it as a value of 0.3 which works well for most head sizes) 

11. Then, type in “fslview” 

12. File → Open (select the output of the eddy current correction process called “data”) 

13. Open the mask in fslview (File → Add, then select the file nodif_brain_mask) and then 

edit the mask (don’t forget to click the ‘lock’ box [icon at the bottom of the screen that 

looks like a padlock]). Tools → Single, then axial view of the scan and mask will appear 

on the right-hand side of the screen (Figure 28). 

14. Click on the button that looks like a pencil, and change the numbers in the 2 boxes from 

1 to 5 (these represent the number of voxels (in 3 directions). Use the + and – buttons 

(or the scroll button on the mouse, or PageUp and PageDown) to navigate up and down 

the axial slices) 
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Figure 29. The FSLview interface displaying a T2-weighted image with a mask superimposed. 

Note: if you receive an error such as “unable to load AtlasWidget” or an error when you try 

and load an atlas, download the fsl-atlases package from neuro.debian.net to fix this - it 

seems to be simply a lack of error handling for the case where atlases are unavailable. Note: 

FSL version 5.0.10 has a new viewer interface called FSLeyes (pronounced “fossilize”). 

15. When you have finished editing the mask, File → Save As, and save the mask as “mask1”. 

16. Fit the diffusion tensor model using the DTIFIT toolbox (within FSL; i.e. select FDT 

Diffusion button), then DTIFIT Reconstruct diffusion tensors, and then select the box 

“specify input files manually”. To create the .bvec and .bval files, open them in Excel 

(separately), transpose them, copy them into Notepad, then save them as separate plain 

text files 

17. Select the correct files (data, mask1, output name, gradient directions (.bvec) and b-

values (.bval). 

18. Click “Go” 

It’s important to know all of these pre-processing steps, so now I can tell you that they can 

all be carried out with one simple recently-released command called “dti_preprocess”. It 

also dewarps Bzero inhomogeneity distortion. Furthermore, if you add the -B flag at the end 

of the command, then a rotated bvec will also be produced. To install this script, follow the 

instructions on this url: http://www.bic.mni.mcgill.ca/~thayashi/dti.html . Make sure to 

check the mask before viewing the output; if the mask is not accurate then you will need to 

http://www.bic.mni.mcgill.ca/~thayashi/dti.html
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fix it, modify the script to call your edited mask, and then rerun the script. Some good 

editors are vi, nano, and kate. However, it is based on the old eddy command, not the one 

introduced in 5.0.9. 

THEN, you are ready for group analyses, as follows: 

1. Navigate to the “mytbss” directory and type in the following (analyses MUST be run 

from a directory called mytbss, and you MUST have the template in that directory called 

FA_2_FMRIB58_1mm.cnf, unless you choose to use your own template) 

2. tbss_1_preproc *.nii.gz 

3. After a few minutes, a message will appear in the terminal suggesting step 2 (which will 

take around 5 to 15 minutes per scan, depending upon the scan dimensions and your 

computer’s resources), but first, check the output of tbss_1 by navigating to the 

mytbss/FA/slicesdir directory and double-clicking on the file called “index.html”: this will 

display 9 slices from each subject’s scan – check that none are upside down, back to 

front, or too bright or dull. To flip a scan along x, y, or z, try different combinations of the 

following command: fslswapdim data.nii.gz z y x dataoutput.nii.gz. If upside down, try: 

fslswapdim data.nii.gz –x y –z dataoutput.nii.gz 

4. After you are sure each scan is in the correct orientation, proceed to the next step: 

5. tbss_2_reg -T  

6. tbss_3_postreg -S 

7. Now you can check the output by typing the following: 

8. cd stats 

9. fslview all_FA -b 0,0.8 mean_FA_skeleton -b 0.2,0.8 -l Green 

10. For Step 4 (thesholding, which will take a minute or two), type in the following: 

11. tbss_4_prestats 0.2 

12.  Now run the group stats. For this, first check the order of your scans by typing: 

13. cd FA 

14. imglob *_FA.*    This will list all of the subjects’ data in the order to be processed 

15. Then run the analysis: 

16. cd ../stats 

17. design_ttest2 design 7 11     (this makes the matrix; note the numbers in this example 

are for comparing group 1 with N=7 versus group 2 with N=11) 

18. Then type the following (will take a few hours to process) 

19. randomise -i all_FA_skeletonised -o tbss -m mean_FA_skeleton_mask -d design.mat -t 

design.con -n 5000 --T2 -v      IMPORTANT! Note the double small dash before T2 i.e. --

T2, not dash T2 i.e. -T2 

20. To view the results, type in the following: 

21. fslview $FSLDIR/data/standard/MNI152_T1_1mm mean_FA_skeleton -l Green -b 

0.2,0.8 tbss_corrp_tstat1 -l Red-Yellow -b 3,6 tbss_tstat2 -l Blue-LightBlue -b 3,6 

22. Note: tbss_p_tstat is the UNCORRECTED result, tbss_corrp_tstat is the CORRECTED 

result. 
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Note: to view significant differences at p=0.05, change the first slider bar (Min) to 0.95 

(enter it manually rather than using the slider bar), and the value below it (Max) to 1 (as 1-

0.95=0.05). Update: To produce uncorrected results from randomize on FSL 5.0.9 (and 

above) you now need to add the -uncorrp flag. 

To process non-FA data: 

1. Create a directory for each non-FA dataset (e.g. L1, L2, L3, MD, radial diffusivity) 

2. Copy over the relevant data into those directories 

3. Rename each file in the non-FA folders to be EXACTLY the same names as listed in the 

original FA dataset (which will now be in a directory called “origdata”). For example, if 

your original (FA) data ended in the filename _FA.nii.gz then you must rename your non-

FA data file to also end in _FA.nii.gz . You can do this by carrying out the following 

commands within each directory: 

 

for i in ./*L1*;do mv -- "$i" "${i//L1/FA}";done 

for i in ./*L2*;do mv -- "$i" "${i//L2/FA}";done 

for i in ./*L3*;do mv -- "$i" "${i//L3/FA}";done 

for i in ./*MD*;do mv -- "$i" "${i//MD/FA}";done 

 

4. Type in “tbss_non_FA L1” (from the mytbss directory) to begin processing the L1 data 

5. cd stats 

6. randomise -l all_L1_skeletonised -o tbss_L1 -m mean_FA_skeleton_mask -d design.mat 

-t design.con -n 5000 --T2 -V 

 

To name the white matter bundle where there are  significant voxels, open the built-in 

atlases (Tools → Toolbars → Atlas tools) and then select the voxel of interest: the atlases 

will state the name of the white matter fibre that click on. 

 

NOTE: to create radial diffusivity data (the average of L2 and L3), type in the following script 

(created by Dr Kerstin Pannek) from your working directory: 

l2dir="L2" #edit this line 
l3dir="L3" #edit this line 
cd $l2dir 
list=`ls *.nii.gz` 
cd ../ 
mkdir radial_diffusivity 
for x in $list 
do 
 echo "calculating radial diffusivity for $x" 
 fslmaths $l2dir/$x -add $l3dir/$x -div 2 radial_diffusivity/$x 



Handbook of Structural Brain MRI Analysis. October 2019 

59 
 

done 
 

Presenting the results 

If you don’t like typing commands, then follow these steps to show the results (assuming 

there is greater FA in the first group): 

1. Open fslview 

2. File → Open 

3. Select the file called “all_FA.nii.gz” 

4. Select the file called “all_FA_skeletonized.nii.gz” 

5. Select the file called “tbss_tfce_corrp_tstat1.nii.gz” 

6. Change the Min value to 0.95 and the Max value to 1 

7. The red-yellow voxels are the voxels of FA that are significantly greater in the first group 

(if there is greater FA in the second group, then these voxels will appear after loading 

tbss_tfce_corrp_tstat2.nii.gz) 

8. To show the results in 3d, select “Tools” then “3D Viewer” and adjust the transparencies 

accordingly 

9. If you want to show the differences more easily, then you need to use the “fill” 

command that makes the white matter voxels thicker so they are more easily visualised: 

tbss_fill tbss_tfce_corrp_tstat1 0.95 mean_FA tbss_fillFAp95 

That command will apply the “tbss_fill” command to the file called “tbss_tfce_corrp_tstat1”, 

threshold it at a p-value of 0.95, and save the output as “tbss_fillFAp95” 

The result (tbss_fillFAp95) can then be added in fslview. 

If you want to show these results using a Windows program, then use MRIcro: 

1. File → Open 

2. Select the T1-weighted or MNI DTI template 

3. Overlay → Load image overlay 

4. Select “tbss_fillFAp95” 

5. The tbss_fillFAp95 will now be superimposed onto the template 

6. To show the differences slice-by-slice, click on the “Etc” pull-down menu then select 

“Options” 

7. Enter the slice numbers you want to display, and whether you want to show left 

hemisphere over right (or the other way around), the extent of slice overlap, and 

whether you want to display transverse (axial) or coronal slices, then click “OK”. Figure 

29 is an example of the screen after you have completed this (the top row is slice by slice 

with significant FA voxel at a p-value of 0.05, and the bottom row is fslview using the 3d 

viewer; merged in Powerpoint): 
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Figure 30. TBSS results presented from axial and 3D-rendered perspectives. 

 

Note about eddy current and movement correction: 

If you have used the older version of the FSL GUI for eddy and movement correction (and 

not ‘eddy’ or ‘dti-preprocess’), then you will need, for each subject, to create individualised 

gradient tables (.bvec) based on the ecclog (called “data.ecclog”, which is an output file 

after correction is complete in FSL), as suggested by Leemans and Jones (2009) and Rohde 

et al. (2004). To do this, type in the following fdt_rotate_bvecs command: 

fdt_rotate_bvecs nameoforiginalgradienttable.bvec nameofnewgradienttable.bvec 

data.ecclog 

Sometimes you will need to transpose (easiest to do this in Excel) the original gradient table 

because fdt_rotate_bvecs expects the original bvec file to be 3 columns (not 3 rows). Note 

that dti_process rotates the bvec for you if you add a -B flag at the end of the command. 

To extract mean value for ROIs according to the JHU White Matter Atlas 

You need to extract the ROIs from the Atlas and convert them into masks; they are 

numbered as “intensities” when viewed with FSLview. For example, corpus callosum (middle) 

is 4. 
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First, copy the file “JHU-WhiteMatter-labels-1mm.nii.gz” from the fsl/atlases directory into 

your tbss/stats directory. Then extract the ROIs (to make them masks) with the following 

commands (script created by Dr Melissa Kirkovski): 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 1 -uthr 1 cer_peduncle 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 2 -uthr 2 pontine_crossing_tract 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 3 -uthr 3 ant_CC 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 4 -uthr 4 CC 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 5 -uthr 5 post_CC 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 7 -uthr 7 R_corticospinal_tract 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 8 -uthr 8 L_corticospinal_tract 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 11 -uthr 11 R_Inf_cer_peduncle 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 12 -uthr 12 L_Inf_cer_peduncle 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 13 -uthr 13 R_Sup_cer_peduncle 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 14 -uthr 14 L_Sup_cer_peduncle 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 15 -uthr 15 R_cer_peduncle 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 16 -uthr 16 L_cer_peduncle 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 17 -uthr 17 r_alic 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 18 -uthr 18 l_alic 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 19 -uthr 19 r_plic 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 20 -uthr 20 l_plic 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 23 -uthr 23 R_Ant_cor_rad 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 24 -uthr 24 L_Ant_cor _rad 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 25 -uthr 25 R_Sup_cor_rad 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 26 -uthr 26 L_Sup_cor_rad 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 27 -uthr 27 R_Post_cor_rad 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 28 -uthr 28 L_Post_cor_rad 

fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 31 -uthr 31 R_ilf 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 32 -uthr 32 L_ilf 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 33 -uthr 33 R_unc 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 34 -uthr 34 L_unc 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 35 -uthr 35 R_cing 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 36 -uthr 36 L_cing 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 37 -uthr 37 R_cing_hipp 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 38 -uthr 38 R_cing_hipp 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 39 -uthr 39 R_hipp 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 40 -uthr 40 L_hipp 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 41 -uthr 41 R_slf 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 42 -uthr 42 L_slf 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 45 -uthr 45 R_unc_needsTBC 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 46 -uthr 46 L_unc_needsTBC 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 47 -uthr 47 R_tapetum 
fslmaths JHU-WhiteMatter-labels-1mm.nii.gz -thr 48 -uthr 48 L_tapetum 
 

Then, apply the “fslmeants” command to extract the values within each ROI (mask) from your all_FA.nii.gz file:  

FA 

fslmeants -i all_FA.nii.gz -o FA_mean_cer_peduncle.txt -m cer_peduncle.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_ant_CC.txt -m ant_CC.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_CC.txt -m CC.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_post_CC.txt -m post_CC.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_r_alic.txt -m r_alic.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_l_alic.txt -m l_alic.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_r_plic.txt -m r_plic.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_l_plic.txt -m l_plic.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz 
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fslmeants -i all_FA.nii.gz -o FA_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz 

fslmeants -i all_FA.nii.gz -o FA_mean_R_ilf.txt -m R_ilf.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_L_ilf.txt -m L_ilf.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_unc.txt -m R_unc.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_L_unc.txt -m L_unc.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_cing.txt -m R_cing.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_L_cing.txt -m L_cing.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_hipp.txt -m R_hipp.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_L_hipp.txt -m L_hipp.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_slf.txt -m R_slf.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_L_slf.txt -m L_slf.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_R_tapetum.txt -m R_tapetum.nii.gz 
fslmeants -i all_FA.nii.gz -o FA_mean_L_tapetum.txt -m L_tapetum.nii.gz 
 

L1 
 
fslmeants -i all_L1.nii.gz -o L1_mean_cer_peduncle.txt -m cer_peduncle.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_ant_CC.txt -m ant_CC.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_CC.txt -m CC.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_post_CC.txt -m post_CC.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_r_alic.txt -m r_alic.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_l_alic.txt -m l_alic.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_r_plic.txt -m r_plic.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_l_plic.txt -m l_plic.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_R_ilf.txt -m R_ilf.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_L_ilf.txt -m L_ilf.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_unc.txt -m R_unc.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_L_unc.txt -m L_unc.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_cing.txt -m R_cing.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_L_cing.txt -m L_cing.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_hipp.txt -m R_hipp.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_L_hipp.txt -m L_hipp.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_slf.txt -m R_slf.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_L_slf.txt -m L_slf.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_R_tapetum.txt -m R_tapetum.nii.gz 
fslmeants -i all_L1.nii.gz -o L1_mean_L_tapetum.txt -m L_tapetum.nii.gz 
 
L2 
 
fslmeants -i all_L2.nii.gz -o L2_mean_cer_peduncle.txt -m cer_peduncle.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_ant_CC.txt -m ant_CC.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_CC.txt -m CC.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_post_CC.txt -m post_CC.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz 
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fslmeants -i all_L2.nii.gz -o L2_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_r_alic.txt -m r_alic.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_l_alic.txt -m l_alic.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_r_plic.txt -m r_plic.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_l_plic.txt -m l_plic.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_R_ilf.txt -m R_ilf.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_L_ilf.txt -m L_ilf.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_unc.txt -m R_unc.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_L_unc.txt -m L_unc.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_cing.txt -m R_cing.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_L_cing.txt -m L_cing.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_hipp.txt -m R_hipp.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_L_hipp.txt -m L_hipp.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_slf.txt -m R_slf.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_L_slf.txt -m L_slf.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_R_tapetum.txt -m R_tapetum.nii.gz 
fslmeants -i all_L2.nii.gz -o L2_mean_L_tapetum.txt -m L_tapetum.nii.gz 
 
L3 
 
fslmeants -i all_L3.nii.gz -o L3_mean_cer_peduncle.txt -m cer_peduncle.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_ant_CC.txt -m ant_CC.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_CC.txt -m CC.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_post_CC.txt -m post_CC.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_r_alic.txt -m r_alic.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_l_alic.txt -m l_alic.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_r_plic.txt -m r_plic.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_l_plic.txt -m l_plic.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_R_ilf.txt -m R_ilf.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_L_ilf.txt -m L_ilf.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_unc.txt -m R_unc.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_L_unc.txt -m L_unc.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_cing.txt -m R_cing.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_L_cing.txt -m L_cing.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_hipp.txt -m R_hipp.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_L_hipp.txt -m L_hipp.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_slf.txt -m R_slf.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_L_slf.txt -m L_slf.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_R_tapetum.txt -m R_tapetum.nii.gz 
fslmeants -i all_L3.nii.gz -o L3_mean_L_tapetum.txt -m L_tapetum.nii.gz 
 
MD 
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fslmeants -i all_MD.nii.gz -o MD_mean_cer_peduncle.txt -m cer_peduncle.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_ant_CC.txt -m ant_CC.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_CC.txt -m CC.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_post_CC.txt -m post_CC.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_r_alic.txt -m r_alic.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_l_alic.txt -m l_alic.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_r_plic.txt -m r_plic.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_l_plic.txt -m l_plic.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_R_ilf.txt -m R_ilf.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_L_ilf.txt -m L_ilf.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_unc.txt -m R_unc.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_L_unc.txt -m L_unc.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_cing.txt -m R_cing.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_L_cing.txt -m L_cing.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_hipp.txt -m R_hipp.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_L_hipp.txt -m L_hipp.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_slf.txt -m R_slf.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_L_slf.txt -m L_slf.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_R_tapetum.txt -m R_tapetum.nii.gz 
fslmeants -i all_MD.nii.gz -o MD_mean_L_tapetum.txt -m L_tapetum.nii.gz 
 
Radial_diffusivity 
 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_cer_peduncle.txt -m cer_peduncle.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_pontine_crossing_tract.txt -m pontine_crossing_tract.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_ant_CC.txt -m ant_CC.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_CC.txt -m CC.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_post_CC.txt -m post_CC.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_corticospinal_tract.txt -m R_corticospinal_tract.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_corticospinal_tract.txt -m L_corticospinal_tract.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Inf_cerebellar_peduncle.txt -m R_Inf_cer_peduncle.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Inf_cer_peduncle.txt -m L_Inf_cer_peduncle.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Sup_cer_peduncle.txt -m R_Sup_cer_peduncle.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Sup_cer_peduncle.txt -m L_Sup_cer_peduncle.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_cer_peduncle.txt -m R_cer_peduncle.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_cer_peduncle.txt -m L_cer_peduncle.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_r_alic.txt -m r_alic.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_l_alic.txt -m l_alic.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_r_plic.txt -m r_plic.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_l_plic.txt -m l_plic.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Ant_cor_rad.txt -m R_Ant_cor_rad.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Ant_cor_rad.txt -m L_Ant_cor_rad.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Sup_cor_rad.txt -m R_Sup_cor_rad.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Sup_cor_rad.txt -m L_Sup_cor_rad.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_Post_cor_rad.txt -m R_Post_cor_rad.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_Post_cor_rad.txt -m L_Post_cor_rad.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_ilf.txt -m R_ilf.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_ilf.txt -m L_ilf.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_unc.txt -m R_unc.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_unc.txt -m L_unc.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_cing.txt -m R_cing.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_cing.txt -m L_cing.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_cing_hipp.txt -m R_cing_hipp.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_cing_hipp.txt -m L_cing_hipp.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_hipp.txt -m R_hipp.nii.gz 
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fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_hipp.txt -m L_hipp.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_slf.txt -m R_slf.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_slf.txt -m L_slf.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_unc_needsTBC.txt -m R_unc_needsTBC.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_unc_needsTBC.txt -m L_unc_needsTBC.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_R_tapetum.txt -m R_tapetum.nii.gz 
fslmeants -i all_radial_diffusivity.nii.gz -o radial_diffusivity_mean_L_tapetum.txt -m L_tapetum.nii.gz 

 

To Extract TBSS skeleton  

fslmeants -i all_FA.nii.gz -o FA_mean_skel.txt -m all_FA_skeletonised.nii.gz 

fslmeants -i all_L1.nii.gz -o L1_mean_skel.txt -m all_L1_skeletonised.nii.gz 

fslmeants -i all_L2.nii.gz -o L2_mean_skel.txt -m all_L2_skeletonised.nii.gz 

fslmeants -i all_L3.nii.gz -o L3_mean_skel.txt -m all_L3_skeletonised.nii.gz 

fslmeants -i all_MD.nii.gz -o MD_mean_skel.txt -m all_MD_skeletonised.nii.gz 

fslmeants -i all_radial_diffusivity.nii.gz -o RD_mean_skel.txt -m all_radial_diffusivity_skeletonised.nii.gz 

You will now have many .txt output files. To merge them into a single file with individual 

variable labels, use the following concatenate Matlab script (created by Caley Sullivan): 

%A simple script to import and concatenate .txt files  
  
workingfolder = 'E:\workingdirectory'; %locate your files  
outfolder =  'E:\workingdirectory';          %location your desired output 
outfile = 'Output.txt';                   % save as 'something.txt'   
m= 42;                                    % m= no. data points in .txt files  
decimal = '%.9f'  ;                       % data precision to 9 decimel points           
  
outpath = fullfile(outfolder, filesep, char(outfile)); 
cd(workingfolder); 
  
dirListing= dir(fullfile('*.txt'));  % Imports ALL .txt files in folder  
                                     % Can Edit wilcards if needed  
                                     %e.g. dir(fullfile('*_ant_CC.txt')); 
names={dirListing(:).name}; 
count= numel(names);      
outPath= strcat(outfolder); 
ALLdata = NaN(m,count);             
  
for i=names; 
n= find(ismember(names,i)); 
filename= char(i);  
DELIM = ' '; 
NHEADER= 0; 
data = importdata(filename,DELIM,NHEADER);savefile = 'Output.mat'; 
ALLdata(:,n)=data'; 
end 
  
fid = fopen(outpath,'wt'); 
header= sprintf('%s\t',names{:}); 
header(end)=''; 
dlmwrite(outpath,header,'delimiter',''); 
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dlmwrite(outpath, ALLdata,'delimiter','\t','precision',decimal,'-append') 
fclose(fid); 
cd(outfolder); 
  
clear all; 
 

 

Paired t-test in TBSS 

Say you are comparing 12 subjects’ data before and after treatment, it might be good to try 

a paired t-test instead of the normal t-test. Set this up as follows: 

 

1. In all_FA_skeletonised you should have as first 12 subjects the first scan and as second 12 

subjects the second scan 

2. Use the Glm interface to set up the design and contrast: type Glm 

3. Change from “timeseries design” to “higher order / non timeseries design” 

4. Number of inputs 24 

5. Click again on “higher order / non timeseries design” (otherwise it doesn't accept the 24; 

it’s a bug…) 

6. Click on "Wizard" 

7. Choose "two groups, paired"; "process" 

8. Save as design_paired (or something similar) 

9. This gives you (among other things) the files design_paired.con and design_paired.mat, 

which you can use in randomise. 

 

To test for Left vs Right symmetry, type in the following: 

tbss_sym FA 

 

Then run the single randomize command as follows: 

randomise -i all_FA_skeletonised_left_minus_right.nii.gz -o tbss -m 

mean_FA_symmetrised_skeleton_mask.nii.gz -1 -n 5000 --T2 –V 
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To test for L1 symmetry 

tbss_sym L1 

then: 

randomise -i all_L1_skeletonised_left_minus_right.nii.gz -o tbss -m 

mean_FA_symmetrised_skeleton_mask.nii.gz -1 -n 5000 --T2 -V 

 

Correlating or covarying in TBSS 

Using the Glm module in fsl, you can create matrices to correlate DWI data with other 

variables (e.g. age) or covary for a variable (e.g. severity of depression). This can be 

accomplished via the FEAT module in FSL, or by typing in Glm into a terminal. The following 

wiki is very useful is creating the appropriate matrix: 

http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/GLM#Two-Group_Difference_Adjusted_for_Covariate  

 

TBSS cluster stats 

Using the 'cluster' command. 

Hint: To view options for the cluster command type in to a terminal: cluster -h  

Example: 

Using the examples below will output a text file with a unique number for each of the 

significant clusters at the threshold that you set. It will also give location information and 

the size of the clusters.  

Commands for FA, radial diffusivity (RD), mean diffusivity (MD) and the first eigenvalue or 

axial diffusivity (AD). 

 

-i is the input file from the 'stats' folder 

-t is the threshold. In the example 0.95 (i.e., p=0.05). 

 

cluster -i tbss_tfce_corrp_tstat2.nii.gz -t 0.95 --mm > cluster_t2_95_C_FA.txt 

cluster -i tbss_L1_tfce_corrp_tstat2.nii.gz -t 0.95 --mm > cluster_t2_95_C_AD.txt 

cluster -i tbss_RD_tfce_corrp_tstat2.nii.gz -t 0.95 --mm > cluster_t2_95_C_RD.txt 

cluster -i tbss_MD_tfce_corrp_tstat2.nii.gz -t 0.95 --mm > cluster_t2_95_C_MD.txt 

http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/GLM#Two-Group_Difference_Adjusted_for_Covariate
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cluster -i tbss_tfce_corrp_tstat1.nii.gz -t 0.95 --mm > cluster_t1_95_C_FA.txt 

cluster -i tbss_L1_tfce_corrp_tstat1.nii.gz -t 0.95 --mm > cluster_t1_95_C_AD.txt 

cluster -i tbss_RD_tfce_corrp_tstat1.nii.gz -t 0.95 --mm > cluster_t1_95_C_RD.txt 

cluster -i tbss_MD_tfce_corrp_tstat1.nii.gz -t 0.95 --mm > cluster_t1_95_C_MD.txt 

 

The output file format will look like this: 

 

To transform images, try using the ApplyXFM GUI as that allows you to enter the dimensions 

of your output image directly.  You can also see what command line calls it makes by looking 

at the terminal that it was invoked from once you press Go, if you'd like to be able to do it 

from the command line. 

FSL questions: have a look here: https://www.researchgate.net/topic/FSL   

Whilst eddy_openmp will use all available CPU cores to process eddy, this is now a version 

of eddy that can utilize CUDA which is a language that works with nvidia graphics cards. So, 

instead of eddy_openmp, if you have a nvidia GPU then you can use this command: 

eddy_cuda . This will make eddy processing considerably faster, depending upon your nvidia 

GPU. However, it is important that the version of CUDA you install is compatible with the 

version of eddy_cuda. For example, we have computers with CUDA 8.0 and another with 

CUDA 9.1, so we use eddy_cuda8.0 and eddy_cuda9.1. Whilst it is possible to have different 

versions of CUDA on a single computer, there are reports that this can be problematic. Here 

is a link where you can download different versions of eddy_cuda: 

https://fsl.fmrib.ox.ac.uk/fsldownloads/patches/eddy-patch-fsl-5.0.11/   

The use of eddy_cuda also allows for slice-to-volume correction instead of volume-to-

volume correction. Just add --mporder=5 (or whatever number you see as appropriate) to 

carry out slice-to-volume correction. See Bastiani et al. (2019) for an explanation of how this 

works; it shows that the output is far better when compared with volume-to-volume 

correction, and is really only feasible when using CUDA as the processing is very resource 

intensive. Our group has recently submitted a manuscript demonstrating the recommended 

computer and GPU specifications to run eddy_cuda with or without slice-to-volume 

correction.

https://www.researchgate.net/topic/FSL
https://fsl.fmrib.ox.ac.uk/fsldownloads/patches/eddy-patch-fsl-5.0.11/
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17. DTIstudio: How to measure FA (and other statistics) of white matter tracts 

 

1. Open DTIstudio (Jiang et al., 2006; Figure 30) 

2. File → DTI Mapping  (Figure 31) 

3. Select the “Siemens, GE or Philips DICOM” option. “Continue” (Figure 32) 

4. A page entitled, “DWI-Image Parameters” will appear: select your customized Gradient 

Table file, and values will then appear in each Section of that page. Note that DTIstudio 

expects the gradient table file to be in a specific format, such that 0: x,y,z is the first b-

zero, etc. That is, the first number represents the volume number, and the three 

numbers after the semi-colon represent the x,y,z directions of the gradients for that 

volume (Figure 33) 

5. MAKE SURE THAT THE BOX IS UNTICKED NEXT TO “BYTE SWAP”, AND THAT “ALL 

SLICES” IS SELECTED, “INFERIOR-SUPERIOR”. Make sure the b-zeros look like T2’s and 

you can clearly see the CC 

6. Check that each parameter in each Section is correct; edit if required. “OK” 

7. A new screen will appear with 4 windows (all 3 x 2D orientations + 1 x 3D; Figure 34) 

8. Select the DtiMap tab at the bottom left of the page 

9. Correct for movement by using the AIR (automatic image registration) tool: select all 

diffusion (i.e. not the b-zero) data then move it to the box on the right. “OK” 

10. Click on the “Tensor, Colour Maps etc” tab in the Calculations area (in the right hand 

column; Figure 35) 

11. DTI-Maps options windows will appear. Don’t change any of the Defaults. “OK”. A new 

window may appear, “Reject Outliers?” For the moment, “Yes”, then “OK” 

12. Select the Fibre Tracking button on the bottom of the right-hand column 

13. You may have to flip the gradient tables in x, y, or z, depending upon your acquisition 

parameters “OK” (Figure 36) 

14. A new tab will appear in the very bottom right, “Fiber” 

15. In the upper region of that right-hand column, Click on “ROI-Drawing Enable” 

16. Choose an ROI shape 

17. Apply the shape to one of the 3 quadrants on the screen (i.e. axial, sag, or coronal) 

18. Statistics: Click on the wide rectangular “Statistics” button (Figure 39) 

19. Note in the database (taken from the “Fiber Statistics; Select Fibers” output box):  

20. Number of fibres 

21. Max length (mm) 

22. Min length (mm) 

23. Average length (mm) 

24. # of voxels that fibers go 

25. Anisotropy – FA: Max, Min, Mean, Std 

26. Anisotropy – RA: Max, Min, Mean, Std 

NOTE: DTIstudio uses the FACT tracking algorithm, which means the tractography is 

deterministic (not probabilistic) 
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Figure 31. The DTIstudio software interface. 
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Figure 32. Selecting “DTI Mapping” 
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Figure 33. Select the type of data. 

 



Handbook of Structural Brain MRI Analysis. October 2019 

73 
 

 

 

Figure 34. The DWI Image Parameters interface. 
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Figure 35. DTIstudio after the DICOMS have been imported. 
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Figure 36. DTI-Map options. 
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Figure 37. The Fiber-Tracking Parameters box. 
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Click on the pull-down menu on the right, and select “Color Map – 0” (Figure 37). This will show the RGB colours representing fibre directions. 

Use the right mouse button to zoom in/out on the 3d (top left) image. Press the “+” button (right-side menu) twice to maximize the 2d images. 

 

Figure 38. Selecting the Color Map-0 option from the pull-down menu. 
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Figure 39. An example of corpus callosum tractography as segmented from sagittal (bottom left). 
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Figure 40. Creating tractography statistics.
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If you have more complex diffusion-weighted data, such as multishell (e.g. DSI), a good 

starting point for analysis is DSIstudio (http://dsi-studio.labsolver.org/ ). The online 

documentation is excellent (http://dsi-studio.labsolver.org/Manual ) and shows how 

processing can be completed in 3 simple steps (reading data, reconstruction, and fiber 

tracking) with a great GUI (no typing in code! Although there is also a DSIstudio version 

which allows you to use code). Our preferred software is MRtrix3. 

 

18. MedINRIA 

 

1. Click on the MEDINRIA (Ayache et al., 2007) icon (Figure 40) 

2. Select “Modules” then “DTI Track” 

3. Select the far left icon on the top row of icons (“New .dts”; Figure 41) 

4. A new window appears (“Diffusion weighted MRI dataset importer wizard”; Figure 42) 

5. Click “Next” 

6. Click “Open” and navigate to the directory where your diffusion data is located and 

select the .nii file 

7. Click “Load sequence” (Figure 43) and select the .bvec file from the same directory 

(make sure you have already processed the scans via dcm2nii) 

8. Click “Next” (Figure 44) 

9. Flip the scans as appropriate (Figure 45) 

10. Click “Next”, then “Finish”. Data will then be displayed (Figure 46) 

11. Click on the “Tensor Processing” tab, and then click the colored “FA” button 

12. A few second later the colour maps will appear. If there are any black holes in the 

images, reduce the threshold and then press the FA button again (Figure 47) 

13. Click on the “Bundle Manager” tab (Figure 48) 

14. Click the 14th button from the left (“Track fibers”) 

15. It will take a few minutes to track all of the fibers in the data (very computer resource 

intensive) 

16. Click “j” on the keyboard – this will engage the tracing tool 

17. Using the left mouse button, trace around a ROI. In Figure 48 I have roughly traced 

around the corpus callosum in the bottom left window 

18. Click on the big green “tick” (validate fiber bundle) 

19. Give the ROI a name and then select a colour after the color grid appears 

20. Click on the ROI name (in the case below, it is called CC) and then click on the big blue 

arrow (“Project all fiber bundles on to 2D views”) 

21. Deselect the bottom left box (“Uniform/Orientation Coded Color”), and after a few 

moments, all of the colour fibers will appear on the scans from each orientation (Figure 

49) 

 

 

http://dsi-studio.labsolver.org/
http://dsi-studio.labsolver.org/Manual
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Figure 41. The MedINRIA GUI. 

 

Figure 42. The MedINRIA GUI after selecting New .dts 

 

Figure 43. The data import wizard. 
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Figure 44. Loading the sequence. 

 

Figure 45. Loading the data. 

 

Figure 46. Flip the scan data if necessary. 
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Figure 47. Raw data displayed in MedINRIA. 

 

Figure 48. Altering the threshold. 

 

Figure 49. The bundle manager in MedINRIA. 
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Figure 50. Tracking the fibers. 

 

Click on one of the 2d buttons (top row) to show just one orientation maximized (Figure 50). 

 

 

 

Figure 51. Axial perspective maximized.  
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19A. MRtrix 

MRtrix (Tournier et al., 2012) is originally a Windows program that is easily installed (just 

download it and run the .exe file). One of the great features of MRtrix is that you don’t have 

to make your own bvec matrix. NOTE: there are MANY freeware packages to conduct DTI 

analyses, comprehensively reviewed in Soares et al. (2013). 

1. Open a terminal by clicking the Windows start button 

2. type in cmd 

3. A black terminal window will now open 

4. Navigate to your dataset  (T1-weighted and diffusion data) by using the cd (change 

directory command) and dir command (to list what is in the directory) 

5. Type in the following: 

mrconvert . T1.mif (the program will then ask you to select the directory number of the 

T1-weighted dataset) 

mrconvert . dwi.mif (the program will then ask you to select the directory number of the 

diffusion-weighted dataset; alternatively, replace the “.” with the name of the directory to 

convert) 

mrconvert T1.mif T1.nii  

mrconvert dwi.mif dwi.nii  

mrinfo -grad grad.txt DWI.mif 

average DWI.nii -axis 3 - | threshold - - | median3D - - | median3D - mask_DWI.mif 

dwi2tensor DWI.nii -grad grad.txt dt_DWI.mif 

tensor2FA dt_DWI.mif - | mrmult - mask_DWI.mif fa_DWI.mif 

tensor2vector dt_DWI.mif - | mrmult - fa_DWI.mif ev_DWI.mif 

erode mask_DWI.mif -npass 3 - | mrmult fa_DWI.mif - - | threshold - -abs 0.7 sf_DWI.mif 

streamtrack DT_STREAM DWI.nii -grad grad.txt -seed mask_DWI.mif -mask mask_DWI.mif 

DWI_whole_brain.tck -num 10000 

Alternatively, try this: 

mrconvert {DWI path} diff.mif 

mrconvert {MP2RAGE INV1 path} mp2rage_inv.mif 

average diff.mif -axis 3 - | threshold - - | median3D - - | median3D - mask_DWI.mif 
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dwi2tensor diff.mif dt_DWI.mif 

tensor2FA dt_DWI.mif  - | mrmult - mask_DWI.mif fa_DWI.mif 

tensor2vector dt_DWI.mif  - | mrmult - fa_DWI.mif ev_DWI.mif 

erode mask_DWI.mif -npass 3 - | mrmult fa_DWI.mif - - | threshold - -abs 0.7 sf_DWI.mif 

streamtrack DT_STREAM diff.mif -seed mask_DWI.mif -mask mask_DWI.mif 

DWI_whole_brain.tck -num 10000 

 

Note: if you use the eddy current and movement corrected scans (e.g. output from FSL eddy 

correct) then use the -grad command (e.g. -grad eccgrad.txt) in the “dwi2tensor” command 

line. Make sure to first convert your new gradient table (described on page 53 of this 

Handbook) into MRtrix format by adding the b-value to end of each line of gradients and 

then saving the new gradient table under a new name.txt. However, if you are using MRtrix3 

(page 90), then this is no longer necessary (as there is a flag available in MRtrix3 (-fslgrad) 

that allows you to use the rotated bvec in FSL format). 

 

For probabilistic, replace the last command with this: 

estimate_response DWI.nii -grad grad.txt  sf_DWI.mif -lmax 8 response_DWI.txt 

 

To perform deconvolution (takes time): 

csdeconv DWI.nii -grad grad.txt response_DWI.txt -lmax 8 -mask mask_DWI.mif 

CSD_DWI.mif 

Then: 

streamtrack SD_PROB CSD_DWI.mif -seed mask_DWI.mif -mask mask_DWI.mif 

cst_CSD_DWI.tck -num 10000 

In a single script: 

estimate_response DWI.nii -grad grad.txt  sf_DWI.mif -lmax 8 response_DWI.txt 

csdeconv DWI.nii -grad grad.txt response_DWI.txt -lmax 8 -mask mask_DWI.mif 

CSD_DWI.mif 

streamtrack SD_PROB CSD_DWI.mif -seed mask_DWI.mif -mask mask_DWI.mif 

cst_CSD_DWI.tck -num 10000 
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If the tracks don’t look right, it may be due to an incorrect response file. To display the 

response function: 

disp_profile -response response_DWI.txt 

 

To open the viewer, type in:  

1. mrview 

2. Maximize the screen 

3. File → open 

4. Open the T1-weighted file ending in .mif 

5. Hold the CONTROL keyboard key and then use the mouse scroller to change the zoom 

6. View → sidebar 

7. Hold down the right mouse button and move it up and down for brightness, and left and 

right for contrast 

8. Right click in the “tracks” window, and select the tractography (called “whole_brain.tck”) 

9. Change the value from 5.0 to 20.0 (Figure 51) 

 

Figure 52. Probabilistic whole-brain tractography in MRtrix. 

• Use the mouse scroller to navigate through the slices 

• Press S for sagittal, A for axial, or C for coronal 

• Click on “depth blend” to see the tracks in depth (i.e. 3d) 

• To see the scan in 3d, untick the “Lock to images axes (under the “View” pull-down 

menu; Figure 52) and untick the “crop to slab” option (bottom right) 
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Figure 53. The pull-down View menu in MRtrix. 

Click the CONTROL key and the middle mouse key to reorientate the scan and play around 

with the “opacity” and “line thickness” 

 

Figure 54. Whole-brain tractography in MRtrix with altered brightness and contrast. 
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DRAWING ROIs: 

1. Load up T1 using mrview 

2. Go to View, Sidebar 

3. Select ROI Analysis in drop down 

4. Right click in blank box on right, click New 

5. Specify filename 

6. To draw, Shift + left click  

7. To remove, Ctrl + Shift + left click 

 

 

SPHERICAL ROIS: 

 e.g. 

streamtrack SD_PROB CSD_DWI.mif -seed 24.52,-25.48,9.39,5 -include 9.76,-86.94,-

2.16,10 -mask mask_DWI.mif LGN_01Lp.tck -num 10000 

 

Spherical ROIs are xco-ordinate, yco-ordinate, zco-ordinate, size 

Get co-ordinates from T1 in mrview, bottom left ('position') 

Commands: 

-seed 

-include (only track if it goes from seed->include region) 

-exclude (don't track if it goes from seed->exclude region) 

tck file is a tract file, you can load this in via the sidebar 

 

To show whole brain tractography: 

1. Unclick “crop to slab” (bottom right) 

2. Uncheck “lock to axes” (through the View pull-down menu) 

3. Control-middle-mouse to rotate 
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Example of using ROIs. In this example, using deterministic tracking of the left optic 

radiations from a band of Gennari ROI, trigone ROI, and LGN ROI, and saving the 

tractography as left_optic: 

 

streamtrack DT_STREAM DWI.nii -grad grad.txt -seed left_bog.mif -include left_lgn.mif –

include left_trigone.mif -mask mask_DWI.mif left_optic2.tck -num 10000 

 

For probabilistic tractography, try this: 

streamtrack SD_PROB DWI.nii -seed left_bog.mif -include left_lgn.mif -mask 

mask_DWI.mif cst_csd.tck 

 

Figures 55 and 56 show the result after adding in a few -exclude co-ordinates (red spheres): 

 

Figure 55. Deterministic optic radiation tractography with exclusion spheres. 
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Figure 56. Probabilistic optic radiation tractography with exclusion spheres. 

If your DWI data does not align accurately with the T1-weighted data, we recommend using 

FLIRT (part of the FSL package) to align the scans. That is, align the T1-weighted scan to the 

DWI data (not the other way around). To achieve an even more accurate alignment, first 

extract a b-zero volume from the DWI dataset using the fslroi command: 

fslroi dwi.nii.gz  nodif 0 1 

The output from that command will be a separate file called nodif.nii.gz 

Then use FLIRT as follows: 

flirt -in t1.nii -ref nodif.nii -out t1_reg.nii -omat t1_reg.mat -bins 256 -cost normmi -

searchrx -5 5 -searchry -5 5 -searchrz -5 5 -dof 6 -interp trilinear 

The output from that command will be a separate file called t1_reg.nii 

Then open mrview, open t1_reg.nii and the dwi.nii should align accurately to it. 

To extract FA values from tractography 

tracks2prob -template fa_DWI.mif nameoftrack.tck FA_mask_track.mif 

mrstats fa_DWI.mif -mask FA_mask_track.mif 

To extract FA values from tractography within a ROI mask 
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mrstats fa_DWI.mif -mask name_of_roi.mif 

Note that there is a ‘track density’ feature in MRtrix; however, this is meant for the purpose 

of validating neuroanatomy. That is, metrics derived from this feature are not clinically 

interpretable (although track weighted can be quantitatively useful). Note as well that it is 

suggested that you extract at least 1million tracts before running the track density 

command. 

To run track density at 500 micron resolution: 

tracks2prob DWI_whole_brain.tck -vox 0.5 tdi.mif 

To run TDI on specific tracts that you have already created: 

tracks2prob name_of_track_1million.tck -vox 0.5 tdi_1million.mif 

 

19B. MRtrix3 

Note that the examples shown above are from using MRtrix version0.2.x. However, there is 

a newer (and far more comprehensive) version of MRtrix called MRtrix3 

(https://github.com/MRtrix3/mrtrix3/wiki; 

https://media.readthedocs.org/pdf/mrtrix/latest/mrtrix.pdf). Some of the commands are 

different (https://github.com/MRtrix3/mrtrix3/wiki/MRtrix3-commands ; 

http://mrtrix.readthedocs.io/en/latest/reference/mrtrix2_equivalent_commands.html), but 

it offers better algorithms, and additional features such as orthogonal views (i.e. display 

coronal, axial, and sagittal simultaneously), 3-dimensional rendering (Figure 56), flood-fill 

ROI module, SIFT (Spherical-deconvolution Informed Filtering of Tractograms; Smith et al., 

2013), connectome modules, as well as dixel and fixel analysis. Note that to get the best 

results from SIFT, the authors advise that a b-value of at least 3000 is used, and that 

reverse-phase encoded bzero volumes (also known as blip-up-blip-down) are acquired as 

well. However, there is talk that SIFT may not be required for such blipped data. Note that in 

MRtrix3, spherical harmonic basis is now orthonormal. This suggests that the old CSD files 

generated in MRtrix0.2.x are not valid for analysis by MRtrix3 without conversion. And the 

FOD file generated in MRtrix3 is also not reciprocally valid for MRtrix0.2. 

https://github.com/MRtrix3/mrtrix3/wiki
https://media.readthedocs.org/pdf/mrtrix/latest/mrtrix.pdf
https://github.com/MRtrix3/mrtrix3/wiki/MRtrix3-commands
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Figure 57. 3-dimensional rendering of optic radiation track density superimposed over the 

subject’s T1-weighted MPRAGE scan in MRtrix3. 

 

As always, before undertaking the steps below, cd to your DICOM folder. 

 

Example 1. 

Whole brain tracking using constrained spherical deconvolution (CSD) and the probabilistic 

tracking algorithm iFOD2 (the default). After step 3 (dwi2mask), check the accuracy of the 

mask using mrview and edit if necessary.  

 

mrconvert . T1.mif 

mrconvert . DWI.mif 

dwi2mask DWI.mif DWI_mask.mif 

dwi2response dwi.mif response.txt -mask DWI_mask.mif 

dwi2fod dwi.mif response.txt FOD.mif -mask DWI_mask.mif 

tckgen fod.mif wholebrain_CSD.tck -seed_image DWI_mask.mif -mask DWI_mask.mif -

number 100000 
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Example 2. 

This example lists the commands for whole-brain tractography using the rotated bvecs from 

FSL. Tractography is using CSD and the probabilistic tracking algorithm iFOD2. After step 3, 

check the accuracy of the mask using mrview and edit if necessary.  

 

mrconvert . T1.mif 

mrconvert -fslgrad filename_rot.bvec values_file.bval filename_ecc.nii.gz DWI.mif 

dwi2mask DWI.mif DWI_mask.mif 

dwi2response dwi.mif response.txt -mask DWI_mask.mif 

dwi2fod dwi.mif response.txt FOD.mif -mask DWI_mask.mif 

tckgen fod.mif wholebrain_CSD.tck -seed_image DWI_mask.mif -mask DWI_mask.mif -

number 10000 

To display the response profile: 

shview -response response.txt 

Note: to extract and check the bvec and bval inside the dwi.mif: 

mrinfo dwinii2mif.mif -export_grad_fsl bvec bval 

 

Creating a track density image  

 

Example 1.  

Using a wholebrain track file (as created in previous examples). 

 

tckmap -dec -vox 0.25 wholebrain_CSD.tck wholebrain_TDI.mif 

 

-vox voxel size provide either an isotropic voxel size (in mm3), or comma-separated list of 3 

voxel dimensions. This can be smaller than the acquired voxel size. 
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-dec option performs track mapping in directionally-encoded colour (DEC) space 

To generate maps of tensor-derived parameters 

Examples: 

 

dwi2tensor -mask DWI_mask.mif DWI.mif  DTI.mif 

For FA: 

tensor2metric -fa fa.mif DTI.mif 

For ADC: 

tensor2metric -adc adc.mif DTI.mif  

 

First eigenvalue: 

tensor2metric -num 1 -value firstEV.mif DTI.mif  

Second eigenvalue: 

tensor2metric -num 2 -value secondEV.mif DTI.mif 

Third eigenvalue: 

tensor2metric -num 3 -value thirdEV.mif DTI.mif  

To calculate radial diffusivity in MRtrix3: 

tensor2metric -num 2,3 -mask binarymask.mif diffusiontensorimage.mif -value - | mrmath 

- mean -axis 3 radialdiffusivity.mif 

 

To create colour FA maps: 

dwi2tensor dwi.mif tensor.mif 

tensor2metric tensor.mif -vec dec.mif 

You can also do it in one go using Unix pipes: 

dwi2tensor dwi.mif - | tensor2metric - -vec dec.mif 
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If you want to clean up your results, you can also supply a mask to either command using 

the -mask option. And if you want other types of tensor metrics, you can use e.g. the -fa, -

adc, -ad, rd, etc. options to tensor2metric. 

 

Note that if you're using the updated_syntax (or final MRtrix3 release) branch, you can 

already use the -rd option of tensor2metric to get the radial diffusivity directly. The axial 

diffusivity is simply the first (i.e., largest) eigenvalue.  Soon also available via the -ad option 

of tensor2metric as well. 

 

The most recent version of MRtrix3 before the final release offered an add-on development 

kit referred to as “updated_syntax”. To install it, it is best to remove your current MRtrix3 

installation and start fresh: 

Install MRtrix3 

Install the eigen3 dependencies 

Install the updated_syntax: 

cd /path/to/your/mrtrix3 

git fetch 

git checkout updated_syntax 

./build 

 

The majority of the development version (updated_syntax) of MRtrix3 was related to 

analysis of multishell diffusion data via the new commands “msdwi2fod” and 

“msdwi2response” which work very well. However, in the ‘final’ release (0.3.15), these 

commands were deprecated, so multishell data can be processed with the conventional 

“dwi2fod” and “dwi2response” commands. 

Note: When converting dicoms to .nii or .mif format for use in MRtrix, you do not have to 

use dcm2nii (or the newer version, dcm2niix). Instead, you can use the mrconvert command. 

If you are having trouble with MRtrix3 not recognizing the diffusion encoding in further 

processing steps, then use the following command: 

mrconvert DICOM -stride 1:4  -export_grad_fsl bvecs bvals DWI.nii 

Remember to use your corrected dwi.nii and rotated bvecs when analysing data. 
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Final release of MRtrix3 (version 0.3.15 at June 2016) for single-shell data: 

mrconvert . T1.mif 

mrconvert . DWI.mif 

dwi2mask DWI.mif DWI_mask.mif 

mrinfo dwi.mif -export_grad_fsl bvecs bvals 

dwi2response tax -lmax 8 -mask DWI_mask.mif DWI.mif response.txt  

dwi2fod csd -mask DWI_mask.mif dwi.mif response.txt odf.mif 

tckgen odf.mif wholebrain_CSD.tck -seed_image DWI_mask.mif -mask DWI_mask.mif -

number 10000 

 

For non-CSD deterministic: 

mrconvert . T1.mif 

mrconvert . DWI.mif 

dwi2mask DWI.mif DWI_mask.mif 

mrinfo dwi.mif -export_grad_fsl bvecs bvals 

dwi2response tax -lmax 8 -mask DWI_mask.mif DWI.mif response.txt  

dwi2fod csd -mask DWI_mask.mif dwi.mif response.txt odf.mif 

tckgen -algorithm tensor_det dwi.mif wholebrain_CSD.tck -seed_image DWI_mask.mif -

mask DWI_mask.mif -number 10000  (that is, replace the odf.mif with dwi.mif) 

 

For CSD-deterministic, replace the last line with: 

tckgen -algorithm sd_stream odf.mif wholebrain_CSD.tck -seed_image DWI_mask.mif -

mask DWI_mask.mif -number 10000 

 

Note: Conversion options to dcm2nii: 

If you do not have dcm2nii, you can convert dicoms to .nii or .mif using MRtrix: 

T1-weighted: mrconvert t1_directory/ t1.mif  (or mrconvert t1_directory/ t1.nii) 
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Diffusion: mrconvert dti_directory / -stride -1,2,3,4 dwi.mif (and then convert the dwi.mif 

to .nii: mrconvert dwi.mif -stride -1,2,3,4 -export_grad_fsl bvecs bvals dwi.nii) 

 

Note: It is advisable to first preprocess your data after conversion from dcm to .mif format: 

dwidenoise dwi.mif dwi_denoised.mif 

preproc -rpe_none AP dwi_denoised.mif dwi_denoised_preproc.mif #Note that this step 

includes carrying out eddy_openmp 

dwibiascorrect dwi_denoised_preproc.mif dwi_denoised_preproc_bias_corrected.mif -fsl 

The output of all that preprocessing will be dwi_denoised_preproc_bias_corrected.mif 

Here is a nice pipeline: http://community.mrtrix.org/t/beginner-connectome-pipeline-

mrtrix3-fsl-and-freesurfer/981/1  

 

MAJOR UPDATE! 

Instead of using dwi2response manual -shell XX -lmax YY etc etc, you can use the dhollander 

option to carry out unsupervised estimation of WM, GM and CSF response functions 

WITHOUT a T1 image or segmentation. Make sure to first do a git pull to get access to this 

(and other) updated scripts. 

Try this: 

mrconvert your_dwi_dataset.nii dwinii2mif.mif -fslgrad bvecs bvals 

dwi2response dhollander dwinii2mif.mif wm.txt gm.txt csf.txt 

dwi2mask dwinii2mif.mif mask.mif 

dwi2fod msmt_csd dwi.mif wm.txt fod_wm.mif gm.txt gm.mif csf.txt csf.mif -mask 

mask.mif 

Note that this last line is for MULTISHELL MULTITISSUE (msmt). For single shell, replace the 

last line with this (although msmt works well with single shell, and sometimes better): 

dwi2fod csd dwi.mif wm.txt fod_wm.mif -mask mask.mif 

Note: you may have to delete the first line of the wm.txt file before using it for tckgen: 

tail -n +2 wm.txt > “wm_new.tmp” && mv wm_new.tmp wm.txt 

To obtain directionally encoded colour FA maps with MRtrix3: 

http://community.mrtrix.org/t/beginner-connectome-pipeline-mrtrix3-fsl-and-freesurfer/981/1
http://community.mrtrix.org/t/beginner-connectome-pipeline-mrtrix3-fsl-and-freesurfer/981/1


Handbook of Structural Brain MRI Analysis. October 2019 

99 
 

fod2dec odf.mif dec_fa.mif 

 

MAJOR UPDATE! July 2017 

In late July 2017 MRtrix3 underwent another major revision. Of note, when specifying the 

number of streamlines to track, the flag -number has now been replaced with -select. 

Note: Calamante (2017) suggests using the terms “streamline” and “track” interchangeably, 

to represent a mathematical representation (i.e. a three-dimensional curve generated using 

a tractography algorithm). In contrast, the terms “tract” and “white matter pathway” are 

also used interchangeably to represent the actual biological structure in the brain. 

 

MAJOR UPDATE! May 2018 

Major update to candidate 3 in May 2018 which fixes bugs, adds new flags and replaces 

some commands: http://community.mrtrix.org/t/mrtrix-3-0-release-candidate-3/1624  

 

To merge 2 datasets: 

Convert each image to a format that can hold the DW scheme in the header (i.e. .mif), 

importing the relevant bvecs/bvals in the process, then use mrcat to merge them. So this 

might look like: 

mrconvert dwi1.nii -fslgrad bvecs1 bvals1 dwi1.mif 

mrconvert dwi2.nii -fslgrad bvecs2 bvals2 dwi2.mif 

mrcat dwi1.mif dwi2.mif -axis 3 dwi_all.mif 

 

We highly recommend that you download a great step-by-step tutorial for MRtrix3 (called 

B.A.T.M.A.N) recently made available by Marlene Tahedl (https://osf.io/fkyht/ ).  

http://community.mrtrix.org/t/mrtrix-3-0-release-candidate-3/1624
https://osf.io/fkyht/
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                                                         20. TractSeg 

 

There are a number of packages that aim to fully automate various white matter bundles, 

including TractSeg (Wasserthal et al., 2018). It is based on CNN (convoluted neural 

networks), and fully automates 72 bundles very quickly. 

Start with processing your dMRI data with MRtrix3 so that you have a wm_fod.mif. 

Open a new terminal in the directory where your wm_fod.mif is, and type in: 

 

sh2peaks wm_fod.mif peaks.nii.gz -num 3 

TractSeg -i peaks.nii.gz --bundle_specific_thr ; 

TractSeg -i peaks.nii.gz --output_type endings_segmentation --postprocess ; 

TractSeg -i peaks.nii.gz --output_type TOM --bundle_specific_thr ; 

Tracking -i peaks.nii.gz --tracking_dir TOM_trackings_filt --tracking_format tck ; 

 

The last line essentially converts the tracks into .tck format. The first time you run TractSeg, 

it will download a series of weights. Depending on your network speed, this can take up to 

around 10 to 20 minutes. The next time you run TractSeg, it will be much quicker as it won’t 

need to download the weights again. 

If TractSeg is not in your path, then make sure to include its full path when you execute the 

command. For example, if your TractSeg (and Tracking) commands are in your 

/home/ubuntu/.local/ directory, then the commands above would be: 

 

/home/ubvm18p04/.local/bin/TractSeg -i peaks.nii.gz --bundle_specific_thr ; 

/home/ubvm18p04/.local/bin/TractSeg -i peaks.nii.gz --output_type 

endings_segmentation --postprocess ; 

/home/ubvm18p04/.local/bin/TractSeg -i peaks.nii.gz --output_type TOM --

bundle_specific_thr ; 

/home/ubvm18p04/.local/bin/Tracking -i peaks.nii.gz --tracking_dir TOM_trackings_filt --

tracking_format tck ; 
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21. Some useful Linux commands 

 

• cd (change directory) 

• cd .. (go one directory up) 

• ls (list the directory) 

• ll (instead of ls) or ls -1: this will list the directory as well as the attributes of every in the 

directory (i.e. not just the filenames) 

• exit 

• to force program to close, press CONTROL-C in the terminal 

• mkdir (make a new directory). To remove a directory, type in rmdir 

• which ‘command’ (the directory the command is located in as per the bash file) 

• what is ‘command’ (this displays a single line description about a command) 

• pwd (shows the present working directory) 

• df -k: (this will display the file system disk space usage in bytes) 

• sudo (this will run a command as super user) 

• arrow up (this displays the previous commands used in a terminal) 

 

There are many script languages available to write code in order to automate image processing (e.g. 

bash, Matlab, R, Python, C++). Here are some nice pieces of advice for bash scripting: 

https://fsl.fmrib.ox.ac.uk/fslcourse/lectures/scripting/all.htm  

http://tldp.org/LDP/Bash-Beginners-Guide/html/chap_08.html  
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